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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 22 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 23 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 24 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 25 
public-private partnership enables the creation of practical cybersecurity solutions for specific 26 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 27 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 28 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 29 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 30 
solutions using commercially available technology. The NCCoE documents these example solutions in 31 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 32 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 33 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 34 
Maryland. 35 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 36 
https://www.nist.gov. 37 

NIST CYBERSECURITY PRACTICE GUIDES 38 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 39 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 40 
adoption of standards-based approaches to cybersecurity. They show members of the information 41 
security community how to implement example solutions that help them align more easily with relevant 42 
standards and best practices, and provide users with the materials lists, configuration files, and other 43 
information they need to implement a similar approach. 44 

The documents in this series describe example implementations of cybersecurity practices that 45 
businesses and other organizations may voluntarily adopt. These documents do not describe 46 
regulations or mandatory practices, nor do they carry statutory authority.  47 

ABSTRACT 48 

A cloud workload is an abstraction of the actual instance of a functional application that is virtualized or 49 
containerized to include compute, storage, and network resources. Organizations need to be able to 50 
monitor, track, apply, and enforce their security and privacy policies on their cloud workloads, based on 51 
business requirements, in a consistent, repeatable, and automated way. The goal of this project is to 52 
develop a trusted cloud solution that will demonstrate how trusted compute pools leveraging hardware 53 
roots of trust can provide the necessary security capabilities. These capabilities not only provide 54 
assurance that cloud workloads are running on trusted hardware and in a trusted geolocation or logical 55 
boundary, but also improve the protections for the data in the workloads and in the data flows between 56 
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workloads. When complete, the example solution will leverage modern commercial off-the-shelf 57 
technology and cloud services to address a particular use case scenario: lifting and shifting a typical 58 
multi-tier application between an organization-controlled private cloud and a hybrid/public cloud over 59 
the internet.  60 

KEYWORDS 61 

cloud technology; compliance; cybersecurity; privacy; trusted compute pools  62 
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1 Introduction 134 

The following volumes of this guide show information technology (IT) professionals and security 135 
engineers how we implemented this example solution. We cover all of the products employed in this 136 
reference design. We do not re-create the product manufacturers’ documentation, which is presumed 137 
to be widely available. Rather, these volumes show how we incorporated the products together in our 138 
environment. 139 

Note: These are not comprehensive tutorials. There are many possible service and security 140 
configurations for these products that are out of scope for this reference design. 141 

1.1 Practice Guide Structure 142 

This is a preliminary draft of Volume C of a NIST Cybersecurity Practice Guide currently under 143 
development. This draft is not yet complete because the build of the trusted cloud example 144 
implementation at the NCCoE is ongoing. This draft is provided to reviewers who would like to follow 145 
the ongoing work and stay informed on the progress of the project. Organizations should not attempt 146 
to implement this preliminary draft. 147 

When completed, this National Institute of Standards and Technology (NIST) Cybersecurity Practice 148 
Guide will demonstrate a standards-based reference design and provide users with the information 149 
they need to replicate a trusted cloud solution using trusted compute pools leveraging hardware roots 150 
of trust to provide the necessary security capabilities. This reference design will be modular and can be 151 
deployed in whole or in part. 152 

This guide contains three volumes: 153 

 NIST SP 1800-19A: Executive Summary 154 

 NIST SP 1800-19B: Approach, Architecture, and Security Characteristics – what we built and why 155 

 NIST SP 1800-19C: How-To Guides – instructions for building the example solution (you are 156 
here) 157 

Depending on your role in your organization, you might use this guide in different ways: 158 

Business decision makers, including chief security and technology officers, will be interested in the 159 
Executive Summary, NIST SP 1800-19A, which describes the following topics: 160 

 challenges that enterprises face in protecting cloud workloads in hybrid cloud models 161 

 example solution built at the NCCoE 162 

 benefits of adopting the example solution 163 
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Technology or security program managers who are concerned with how to identify, understand, 164 
assess, and mitigate risk will be interested in NIST SP 1800-19B, which describes what we did and why. 165 
The following sections will be of particular interest: 166 

 Section 3.4.3, Risk, describes the risk analysis we performed. 167 

 Appendix A, Mappings, maps the security characteristics of this example solution to 168 
cybersecurity standards and best practices. 169 

You might share the Executive Summary, NIST SP 1800-19A, with your leadership team members to help 170 
them understand the importance of adopting standards-based trusted compute pools in a hybrid cloud 171 
model that provide expanded security capabilities. 172 

IT professionals who want to implement an approach like this will find the whole practice guide useful. 173 
You will be able to use this How-To portion of the guide, NIST SP 1800-19C, to replicate all or parts of 174 
the build being created in our lab. This How-To portion of the guide provides specific product 175 
installation, configuration, and integration instructions for implementing the example solution. 176 

This guide assumes that IT professionals have experience implementing security products within the 177 
enterprise. While we are using a suite of commercial products to address this challenge, this guide does 178 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 179 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 180 
parts of a trusted cloud implementation leveraging commercial off-the-shelf technology. Your 181 
organization’s security experts should identify the products that will best integrate with your existing 182 
tools and IT system infrastructure. We hope that you will seek products that are congruent with 183 
applicable standards and best practices. Section 4.2, Technologies, in NIST SP 1800-19B lists the 184 
products we are using and maps them to the cybersecurity controls provided by this reference solution. 185 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 186 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 187 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 188 
trusted-cloud-nccoe@nist.gov.  189 

1.2 Build Overview 190 

The NCCoE has been working with its build team partners to create a lab demonstration environment 191 
that will include all of the architectural components and functionality described in Section 4 of NIST SP 192 
1800-19B. This will include a private on-premises cloud hosted at the NCCoE, an instance of the public 193 
IBM Cloud Secure Virtualization (ICSV), and an Internet Protocol Security (IPsec) virtual private network 194 
(VPN) that connects the two clouds to form a hybrid cloud. The private on-premises cloud at the NCCoE 195 
consists of components from Dell EMC, Gemalto, HyTrust, Intel, RSA, and VMware, and the ICSV 196 
instance consists of components from HyTrust, IBM, Intel, and VMware. 197 

mailto:trusted-cloud-nccoe@nist.gov
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Information about the usage scenarios for the build will be included in the next draft of this guide. 198 

1.3 Typographic Conventions 199 

The following table presents typographic conventions used in this volume. 200 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that are 
not hyperlinks; new terms; and 
placeholders 

For language use and style guidance, see 
the NCCoE Style Guide. 

Bold names of menus, options, command 
buttons, and fields 

Choose File > Edit. 

Monospace command-line input, onscreen 
computer output, sample code 
examples, and status codes 

mkdir 

Monospace Bold command-line user input contrasted 
with computer output 

service sshd start 

blue text link to other parts of the document, 
a web URL, or an email address 

All publications from NIST’s NCCoE are 
available at https://www.nccoe.nist.gov. 

1.4 Logical Architecture Summary 201 

Figure 1-1 shows the high-level architecture. It depicts the four main components that comprise the 202 
build: 203 

 HSM component: This build utilizes HSMs to store sensitive keys within the environment. 204 

 Management component: Identical functional management components are instantiated 205 
within each cloud instance. At a minimum, each management component includes VMware 206 
running the virtualization stack, HyTrust providing the asset tagging policy enforcement aspect, 207 
and RSA providing network-visibility, dashboard, and reporting capabilities. The management 208 
components are connected through the VPN to represent one logical management element. 209 

 Compute component: The compute components host the tenant workload virtual machines 210 
(VMs). Asset tagging is provisioned on the compute servers so that policy can be assigned and 211 
enforced to ensure that tenant workloads reside on servers that meet specific regulatory 212 
compliance requirements. 213 

 Workload component: The workload components include VMs, data storage, and networks 214 
owned and operated by the tenant and data owner. Policies are applied to the workloads to 215 

https://www.nccoe.nist.gov/
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ensure that they can run only on servers that meet specific requirements, such as asset tag 216 
policies. 217 

Figure 1-1: High-Level Solution Architecture 218 

 219 

2 Dell/EMC Product Installation and Configuration Guide 220 

The aspects of installing and configuring the Dell/EMC products used to build the example solution have 221 
not yet been fully documented. The completed documentation is planned for inclusion in the next draft 222 
of this guide. 223 

3 Gemalto Product Installation and Configuration Guide 224 

The aspects of installing and configuring the Gemalto products used to build the example solution have 225 
not yet been fully documented. The completed documentation is planned for inclusion in the next draft 226 
of this guide.  227 

4 HyTrust Product Installation and Configuration Guide 228 

The aspects of installing and configuring the HyTrust products used to build the example solution have 229 
not yet been fully documented. The completed documentation is planned for inclusion in the next draft 230 
of this guide.  231 

5 IBM Product Installation and Configuration Guide 232 

This section covers all the aspects of installing and configuring the IBM products used to build the 233 
example solution. For more information, see the IBM Cloud Secure Virtualization (ICSV) site at 234 
https://www.ibm.com/cloud/secure-virtualization. 235 

https://www.ibm.com/cloud/secure-virtualization
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5.1 ICSV Deployment 236 

IBM Cloud Secure Virtualization combines the power of IBM Cloud, VMware Cloud Foundation, HyTrust 237 
security software, and Intel TXT-enabled hardware to protect virtualized workloads. ICSV is deployed on 238 
the IBM Cloud infrastructure according to a VMware, HyTrust, IBM, and Intel validated design reference 239 
architecture. IBM Cloud Secure Virtualization is initially deployed as a four-node cluster within the 240 
choice of clients of available IBM Cloud Data Centers worldwide. Below is a Reference Architecture for 241 
ICSV that shows the separation between IBM Cloud services, ICSV provisioned infrastructure, and 242 
tenant virtual machines (VMs). ICSV utilizes the IBM Cloud Services Network to enable provisioning the 243 
IBM Cloud Private Network to a customer, which in turn protects the virtualized workloads. 244 

 

To deploy the ICSV reference architecture stack, IBM has streamlined the process in three phases for 245 
the customer.  246 
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5.1.1 Pre-Deployment 247 

This phase starts after the customer has agreed to purchase the ICSV stack in the IBM cloud and has 248 
identified the use cases using a workshop or IBM Garage methodology. For the NCCoE project, we had a 249 
good understanding of the use case and the capabilities provided by ICSV. To achieve success in all 250 
three phases, the IBM Services team filled out Table 5-1 and Table 5-2. The information provided in 251 
each table helped us with decisions in later steps. 252 

Table 5-1: Example of IBM Cloud Contact Information Template 253 
 

Name Email Address Phone Number 

Client Sponsor 
 

  

Client Technical Lead    

Client Oversight    

Client Sales Engineer        

IBM Account Exec    

IBM Sales Contact    

IBM OM Contact    

IBM Program Manager (PM)    

IBM Consultant    

Other IBMers     
   

Vendors info (if applicable)    
 

Table 5-2: ICSV Requirement & Deployment Template 254 

Client Input Variables Choices Example Values  

SoftLayer user id 
 

<user_name> from IAAS 

SoftLayer API key 
 

<user_key> from IAAS    

Deployment - VMware Cloud Foundation (VCF) 
or vCenter Server (VCS) 

VCF or VCS VCS 

   

VCS deployment details 
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Client Input Variables Choices Example Values  

Instance name  - TrustedCld 

# of hosts (min. 3)   3 to 20 4 

Instance Primary or Secondary Primary 

Host configuration Small, Medium, Large, 
Custom 

Custom 

Cores 16, 24, 28, 36 24 

Intel core base 2.1, 2.2, 2.3 GHz 2.2 GHz 

RAM (64-1.5 TB) 256 GB 

Data center location Dallas,DC,Boulder,etc Dallas 

Data Storage NFS or VSAN VSAN 

Size of each Data Storage    (1, 2, 4, 8, 12 TB) 2 TB 

Performance of file shares  (2, 4, 10 IOPS/GB) NA 

NFS version - v3.0 or v4.1 for shared drives 
 

NA 

Windows AD  VSI OR VM VM 

Host Prefix - Esxi0 

Domain name (used in Windows AD) - nccoe.lab 

Sub Domain (used by VM) - icsv 

VM License BYO or Purchase Purchase 

    VM Vcenter Server License  - Standard 

    VM vSphere License  - Enterprise Plus 

VM NSX License - Enterprise    

Services to be added 
  

Veeam Yes / No NO 

F5 Yes / No NO 

Fortinet Security Appliance Yes / No NO 

Fortinet Virtual Appliance Yes / No NO 

Zerto version 5.0 Yes / No NO 

HyTrust DataControl Yes / No YES 

HyTrust CloudControl Yes / No YES 

IBM Spectrum Protect Plus Yes / No NO 
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5.1.2 Automation Deployment  255 

The following are steps for ordering an ICSV instance through the IBM portal. 256 

1. Log into the IBM Cloud infrastructure customer portal at 257 
https://console.ng.bluemix.net/catalog/.  258 

2. From the top left corner, select the ‘Hamburger’ menu: 259 

 260 

3. Select VMware from the drop-down menu on the left side. 261 

4. Click on Settings and make sure the correct API key is entered before provisioning the solution. 262 

5. On the IBM Cloud for VMware Solutions screen, select VMware vCenter Server on IBM Cloud. 263 

6. On the next screen, select vCenter Server and click the Create button. 264 

7. In the next window, type in the Instance Name and make sure Primary Instance is highlighted 265 
for Instance type. For the Licensing options, select Include with purchase for all of them. For the 266 
NSX License, select Enterprise from the drop-down menu. 267 

 

https://console.ng.bluemix.net/catalog/
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8. Under Bare Metal Server: 268 

a. For the Data Center Location, open the drop-down menu for NA South and select DAL09. 269 

b. Select Customized since our workload needs a VSAN, which requires a minimum of a four-270 
node cluster.  271 

9. Under Storage:  272 

a. Select vSan Storage.  273 

b. Set the Disk Type and Size for vSAN Capacity Disks to 1.9 TB SSD SED.  274 

c. Select 2 from the drop-down menu for the Number of vSAN Capacity Disks. 275 

d. For vSAN License, select Include with purchase and then choose Enterprise from the drop-276 
down menu. 277 

 

10. For the Network Interface, enter the following: 278 

a. Hostname Prefix: esxi 279 

b. Subdomain Label: icsv 280 

c. Domain Name: nccoe.lab 281 

11. Select Order New VLANs. 282 

12. Under DNS Configuration, select Two highly available dedicated Windows Server VMs on the 283 
management cluster. 284 

13. Under Services, remove Veeam on IBM Cloud 9.5 and select HyTrust CloudControl on IBM 285 
Cloud 5.3 and HyTrust DataControl on IBM Cloud 4.1. 286 
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14. Click on the Provision button in the bottom right-hand corner. This will begin the provisioning 287 
process for the selected topology. It can take roughly 24 hours to complete the automation 288 
deployment. Once deployment has completed, you should receive an email notification. 289 

 

5.1.3  Post-Deployment 290 

This information is needed to set up HTCC to interact with Windows AD and vCenter. The IBM Service 291 
team will set up HTCC so it is ready for HyTrust configuration based on the use cases required by the 292 
client. Table 5-3 shows examples of HTCC configuration parameters. 293 
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Table 5-3: Examples of HTCC Configuration Parameters 294 

Client Input Variables Choices Example Values 

SMTP Server - for email notifications Point to company or enable 
third party sendgrid 

sendgrid 

SNMP Server ? ? 

NTP Server (provided by SL) Use default (10.0.77.54), 
unless specified  

10.0.77.54  
(time.service.networklayer.com) 

   

Windows AD Groups and Users   
 

Group / Users 
  

HTCC Super Admin group ht_superadmin_users ht_superadmin_users 

User in : ht_superadmin_users (Full 
Admin) 

Administrator Administrator 

User: ht_ldap_svc 
HTCC to AD login user 

ht_ldap_svc , unless 
specified by client 

ht_ldap_svc 

User: ht_vcenter_svc 
HTCC to vCenter login user 

ht_vcenter_svc unless 
specified by client 

ht_vcenter_svc 

   

H/W Policy tags   

Country (from BMXI portal, as 
displayed) 

Country Name USA 

State/Province State or Province Name DAL 

Physical Data Center (PDC) Location (IBM Cloud Data 
Center name as displayed) 

DAL09 

Region Region where data center 
is located 

South West 

Classification (User ID-Client name) Custom  

 



PRELIMINARY DRAFT 

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud IaaS Environments 12 

The IBM services team gathers information from the client, such as the examples in Table 5-4, after 295 
understanding the use cases. The information will be used to configure HyTrust, VMware, and Intel 296 
TPM/TXT to enforce workload rules and policy. Once post-deployment is completed, the IBM services 297 
team will perform a verification test and deliver the asset to the client.  298 

Table 5-4: Examples of Additional HTCC Configuration Parameters 299 

Client Input Variables Choices Example Values 

SMTP Server - for email notifications Point to company or enable 
third party sendgrid 

sendgrid 

SNMP Server ? ? 
   

HyTrust H/W TPM Policy Tags  
   

HTCC Compliance Templates - 
Custom 

  
 

Name   Based on PCI, NIST, … 
   

HTCC Scheduled Events   
 

Name   Template or Label 
   

HTCC Policy Labels   
 

Name   Template 
   

HTCC Roles   
 

Default Roles 
  

Users     

ASC_ARCAdmin default ASC_ARCAdmin 

ASC_ARCAssessor default ASC_ARCAssessor 

ASC_ApplAdmin default ASC_ApplAdmin 
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Client Input Variables Choices Example Values 

ASC_BackupAdmin default ASC_BackupAdmin 

ASC_BasicLogin default ASC_BasicLogin 

ASC_CoreApplAdmin default ASC_CoreApplAdmin 

ASC_DCAdmin default ASC_DCAdmin 

ASC_ESXMAdmin default ASC_ESXMAdmin 

ASC_NetworkAdmin default ASC_NetworkAdmin 

ASC_PolicyAdmin default ASC_PolicyAdmin 

ASC_RoleAdmin default ASC_RoleAdmin 

ASC_StorageAdmin default ASC_StorageAdmin 

ASC_SuperAdmin default ASC_SuperAdmin 

ASC_ThirdParty default ASC_ThirdParty 

ASC_UCSLogin default ASC_UCSLogin 

ASC_VIAdmin default ASC_VIAdmin 

ASC_VMPowerUser default ASC_VMPowerUser 

ASC_VMUser default ASC_VMUser 
   

Groups     

ASC_ARCAdmin default ASC_ARCAdmin 

ASC_ARCAssessor default ASC_ARCAssessor 

ASC_ApplAdmin default ASC_ApplAdmin 

ASC_BackupAdmin default ASC_BackupAdmin 

ASC_BasicLogin default ASC_BasicLogin 

ASC_CoreApplAdmin default ASC_CoreApplAdmin 

ASC_DCAdmin default ASC_DCAdmin 
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Client Input Variables Choices Example Values 

ASC_ESXMAdmin default ASC_ESXMAdmin 

ASC_NetworkAdmin default ASC_NetworkAdmin 

ASC_PolicyAdmin default ASC_PolicyAdmin 

ASC_RoleAdmin default ASC_RoleAdmin 

ASC_StorageAdmin default ASC_StorageAdmin 

ASC_SuperAdmin default ASC_SuperAdmin 

ASC_ThirdParty default ASC_ThirdParty 

ASC_UCSLogin default ASC_UCSLogin 

ASC_VIAdmin default ASC_VIAdmin 

ASC_VMPowerUser default ASC_VMPowerUser 

ASC_VMUser default ASC_VMUser 

5.2 Enable Hardware Root of Trust on ICSV Servers 300 

In order to leverage the ICSV instance for hardware roots of trust, steps must be taken to enable these 301 
features within the server BIOS, as well as ensuring features in the VMware products are enabled to 302 
access and leverage these measurements. 303 

5.2.1 Enable Managed Object Browser (MOB) for each ESXi Server 304 

1. Open the vSphere Client and navigate to the relevant host. 305 

2. Click on the Configure tab. 306 

3. On the left-hand side under Software, click on System, then Advanced System Settings. 307 

4. Click on the Edit button. 308 
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5. Modify or add the configuration to enable MOB: Config.HostAgent.plugins.solo.enableMob (set 309 
value to True). 310 

6. To confirm that MOB has been enabled on the host, open http://x.x.x.x/mob, where 311 
x.x.x.x is the IP address of the ESX Server. 312 

5.2.2  Enable TPM/TXT on SuperMicro hosts 313 

1. From the vCenter console, enter the ESX host(s) in maintenance mode. 314 

2. Log into your IBM Cloud console and open a support ticket. In the ticket, specify the following: 315 

a. ESX host(s) you want them to work on. You can have support work on multiple hosts as long 316 
as you have the minimum running as required by your instance—minimum of three hosts 317 
for instances that have VSAN, otherwise two hosts. 318 

b. Enter ticket description as follows: 319 

< Start of ticket description > 320 

We need your assistance to enable TPM/TXT in the BIOS for this IBM Cloud Secure 321 
Virtualization (ICSV) instance. 322 

Please enable the TPM/TXT flags in the BIOS, following the steps in the exact order specified: 323 

1. Reboot the following host(s) specified below and enter into BIOS – <provide the list of 324 
hosts again here for clarity.> 325 
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2. Go to Advanced ‘Trusted Computing’. If TPM cannot be cleared in the Pending Opera-326 
tions option, then reboot to BIOS and enable TPM only. You will need this to clear TPM 327 
in the next reboot. Press F4 to save and exit. 328 

3. On reboot, again go to BIOS and go to Advanced ‘Trusted Computing’. Clear TXT. This 329 
will clear TPM and TXT. Press F4 to save and exit. 330 

4. On reboot go to BIOS and enable TPM only. Press F4 to save and exit. Do not enable 331 
TPM and TXT in the same reboot. They have to be enabled in sequence. 332 

5. On reboot, again go to BIOS and now enable TXT. The TPM should have been enabled 333 
from last step. Press F4 to save and exit. 334 

6. Let the reboot continue to boot to ESX. 335 

Please let me know when you have done this successfully. 336 

< End of ticket description > 337 

c. Once the support person returns the ticket with the task completed, continue with the tasks 338 
below. 339 

3. From the vCenter console, exit maintenance mode. You may need to connect the ESX hosts 340 
again if the host got disconnected. 341 

4. From the vSphere web client or vSphere client, disconnect the host and then connect the host 342 
back. This is needed to have the ESXi host re-read the TPM settings. 343 

5. Check the vCenter MOB to check if TPM/TXT is enabled.  344 

At a minimum, there must be three hosts up in instances that have VSAN. So make sure you only work 345 
on hosts that will ensure this requirement is met. Ideally, work on one host at a time. 346 

5.2.3  Enable TPM/TXT in IBM Cloud 347 

1. Through vCenter, place the ESXi host in maintenance mode. 348 

2. Reboot the ESXi server by pressing the F12 key in the iKVM viewer. 349 

3. Once the server reboots, access the BIOS. Disable the TPM Provision Support, the TXT Support, 350 
and the TPM State, then Save & Exit. 351 
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4. Reboot the server all the way to the ESXi OS level. 352 

5. Reboot the server again using the F12 key. 353 

6. Make sure the OS is not loaded, and access the BIOS. Set the TPM State to Enabled, then Save 354 
& Exit. 355 

7. Let the system boot up, but access the BIOS before the OS is loaded and after IPM-CPU 356 
initialization. If the system boots the OS, you will have to do the above steps again. 357 

8. Enable TXT Support in the BIOS, then Save & Exit. 358 

9. Boot the server to OS hypervisor level. 359 

5.2.4  Validate the TPM/TXT is enabled 360 

1. SSH into the ESX host as root and run the following command: 361 

zcat  /var/log/boot.gz  |  grep –I  tpm 362 

This should show if the TPM library was loaded. 363 

2. Other commands to check are: 364 

vmkload_mod –l  | grep tpm 365 
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grep –i  tpm  /var/log/hostd.log | less –S 366 

3. As a root user, run the following command: 367 

esxcli hardware trustedboot get 368 

 It should show two answers, and both should be true. 369 

5.2.5  Check the vCenter MOB to see if the TPM/TXT is enabled 370 

1. Open a browser with https://<vCenter-console-IP address>/mob to bring the vCenter MOB (do 371 
not use the individual ESXi host MOB). Authenticate using the vCenter credential. 372 

2. Click on different resources of the MOB in the steps shown below: 373 

a. Click on content. 374 

 

b. Search for group-d1 (Datacenters) and click on it. 375 

 

c. Find datacenter-2 (SDDC-Datacenter) and click on it. 376 

d. Search for group-h4 (host) and click on it. 377 

e. Search for domain-c7 (SDDC-Cluster) and click on it. 378 
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f. Search for host, and you will see all the hosts listed with their host names. 379 

  

g. Click on the host that you need to validate. In our demo, we are checking 380 
host1.securek8s.ibm.local 381 

h. Search for method QueryTpmAttestationReport and click on it to invoke the method.  382 

i. Click on Invoke Method. 383 

 

5.2.6 Set up Active Directory users and groups 384 

In this part of the setup, you will create several new organizational units. Remember that this procedure 385 
uses a Windows 2012 server and Microsoft AD to illustrate the steps. Your environment and your 386 
specific steps might be different. This section assumes actions are being performed from the ICSV 387 
Microsoft AD server.  388 

Alternatively, you can follow these steps to set up AD. Note that the values in the screen shots will be 389 
different than your values. 390 

1. In Windows Server, start the Server Manager, if not already started. 391 

2. From the Server Manager window, select Tools -> Active Directory Users and Computers. 392 
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3. Right-click on your domain that has been created based on the instance name you provided by 393 
Windows AD deployment (for VCS) or during VCF deployment creation. For our demo, it is 394 
demo3VCS.local. Select New -> Organizational Unit. You should create the new OU.  395 

 

4. Enter HyTrust as the name of the new unit. Right-click on the HyTrust organizational unit, select 396 
New -> Organizational Unit, and give the name of Groups.  397 

5. Right-click again on the HyTrust organizational unit, select New -> Organizational Unit, and give 398 
the name of Users. This group will be used to allow a user to communicate between HTCC and 399 
AD. The directory hierarchy should now look similar to this: 400 

 401 

6. Add two users to the Users group. To do this, right-click on the HyTrust/Users organizational 402 
unit and select New -> User.  403 
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7. The first user is the primary user account that will be used to communicate between HTCC and 404 
AD. In the pop-up screen for users, enter user information as appropriate. The screen might 405 
look like this: 406 

Full name: HyTrust LDAP Lookup 407 

User logon name: ht_ldap_svc 408 

 

8. Click Next to go to the user password screen. It asks you to establish a password and some 409 
password options for the user. Enter or verify these fields: 410 

a. Enter and confirm a password for the user. The password needs to have at least one upper 411 
case letter, otherwise the user will not be created. Note the password in the deployment 412 
spreadsheet. 413 

b. Uncheck this option: User must change password at next logon. 414 

c. Check this option: Password never expires. 415 

d. Click Next. 416 

e. Verify the information and finish. 417 

9. The second user will be used as the service account when HTCC interacts with vCenter. You 418 
could use the Administrator@vsphere.local account, but best practice is to create a specific 419 
service account in AD and use that. Create the second user (in the same way as the first user) 420 
with the following values: 421 



PRELIMINARY DRAFT 

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud IaaS Environments 22 

Full name: HyTrust VCenter svc account 422 

User logon name: ht_vcenter_svc 423 

Ensure that the password never expires. 424 

10. You will now create two subgroups under Groups.  425 

a. First, right-click on the Groups organizational unit and select New -> Group. 426 

b. When prompted, enter a name for the new group: bcadmins. Later, you will tell HTDC to 427 
use this group when communicating with HTCC to verify boundary checks. Keep the rest of 428 
the options (Group scope and type) the default values as shown below. Press OK to create 429 
the group. 430 

 

c. Right-click again on the Groups organizational unit and select New -> Group. 431 

d. When prompted, enter a name for this group: ht_superadmin_users and press OK. Later, 432 
you will tell HTCC to use this group to specify administrative users of HTCC.  433 

11. You will now add members to the superadmin group.  434 

a. To do this, right-click on the ht_superadmin_users group, and select Properties. 435 

b. In the pop-up window, select the Members tab, then click Add. 436 
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c. In the next pop-up screen, enter an object name Administrator, and click on Check Names. 437 
If no error is returned, click OK.  438 

 

12. Close the AD control panel. 439 

You are now ready to set up HTCC authentication to work with AD, as described in the next procedure. 440 

5.2.7 Join vCenter to the AD domain 441 

We need to integrate the AD domain into vCenter so that we can later give the AD HyTrust service 442 
account vCenter permissions. You first have to join the vCenter to the AD domain, and then add the AD 443 
user to vCenter. Note that this is already done for VCS and VCF. However, you may want to check using 444 
the instructions below. 445 

1. To check if vCenter is already joined to the AD Domain, SSH into PSC. 446 

2. Run the following command: 447 

/opt/likewise/bin/domainjoin-cli  query 448 

If the output indicates it’s already joined, you can skip the rest of this section (5.2.7). 449 

3. If it’s not already joined, run the following command to join it: 450 

/opt/likewise/bin/domainjoin-cli  join  <domain-name>  <AD 451 
Administrator user>  <password>  452 

Example: 453 

/opt/likewise/bin/domainjoin-cli  join  demo3vcs.local  Administrator Passw0rd 454 

Output: 455 

Joining to AD Domain:   demo3vcs.local 456 
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With Computer DNS Name: psc.demo3vcs.local 457 

SUCCESS 458 

Then reboot. 459 

4. SSH into PSC again and verify that the join has succeeded by issuing the following command: 460 

/opt/likewise/bin/domainjoin-cli  query 461 

 

5.2.8 Add AD HyTrust-vCenter service user to vCenter as Administrator 462 

This is for both the VCS and VCF instances. 463 

1. In the vSphere Web Client, go to Administration and then Users and Groups. Click on Groups, 464 
then Administrators, and select the Group Members Add icon. 465 
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2. In the Add Principals panel, select the Windows AD Domain (demo.local in our example), scroll 466 
down and select the user ht_vcenter_svc user (that was created in Windows AD), and click on 467 
the Add button. That user should appear in the Users list. Then press the OK button. 468 

 

You have successfully added the Windows AD HyTrust vCenter LDAP id as part of the Administrator 469 
group. This id will be used for all interaction between HTCC and vCenter, when the vCenter is added to 470 
HTCC. 471 

5.2.9 Add AD HyTrust-vCenter service user to vCenter Global Permissions 472 

1. Go to the vCenter web client. Under Administration, click on Global Permissions.  473 

2. Add the AD user for the HyTrust-vCenter service, ht_vcenter_svc, and give it Administration 474 
permission. 475 
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5.2.10   Configure HTCC for AD authentication 476 

HTCC requires a directory services solution. In this deployment solution, HTCC authentication will be set 477 
up to work with Microsoft AD. Before you configure HTCC to use AD, you must define two groups and 478 
one user. You can do this via existing AD entries or create entries just for HTCC (as is the case in our 479 
implementation). 480 

By default, HTCC is set to use a demo userid/password authentication. Once you change to AD 481 
authentication, you cannot revert back to the demo authentication. 482 

If AD is configured with SSL, the AD server’s SSL certificate must be imported into HTCC. To configure 483 
HTCC with an AD server with SSL configuration, refer to the HTCC Administration Guide for the following 484 
steps: 485 

1. Import AD Server certificate into HTCC. Refer to the HTCC Administration Guide section titled 486 
“Installing a Third-party Root Certificate.” 487 

2. Configure AD with SSL in HTCC. Refer to the HTCC Administration Guide section titled 488 
“Integrating the Appliance with Active Directory.” 489 

To set up HTCC authentication, follow these steps: 490 
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1. Log onto the HTCC web console, using URL https://<HTCC-Virtual-IP>/asc with the default 491 
username of superadminuser and the password Pa$$w0rd123! 492 

2. From the HTCC dashboard, select the Configuration menu, and then Authentication. 493 

3. Change the Authentication Server Type to Directory Service and accept your changes.  494 

4. You should see a screen for configuring the service account. In the service account name field, 495 
enter the username and password that was created earlier in the setup steps for AD. Make sure 496 
that the Default domain name is the one you used to deploy the instance. In our demo, it’s 497 
demo3vcf.local. Use the password for user ht_ldap_svc that you used in Windows AD 498 
configuration. The screen might look like this: 499 

 

5. Click Next, and you will see the domain listed. Click Next again.  500 

6. You should now see the Role-Group Mapping page. Look under the ASC_SuperAdmin section 501 
entry. Confirm that your AD domain is listed in the selected pull-down entry. In the group name 502 
field, enter the admin group name, ht_superadmin_users, that you created earlier in the initial 503 
AD setup. HTCC will attempt to perform predictive searches to allow for name completion. 504 
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7. Click Next and review the summary. If it is correct, finish. If AD is working correctly, the web 505 
interface will automatically log you out.  506 

 

8. Log back in using the Administrator user and password of your Windows AD/DNS Server (which 507 
is the domain controller). Recall that we had added ‘Administrator’ to the 508 
ht_superadmin_users group in Windows AD. 509 

At this point, AD should be correctly set up for deployment. You are ready to set up the trust attestation 510 
service. 511 

5.3 Add Hosts to HTCC and Enable Good Known Host (GKH) 512 

You will first add hosts in vCenter and then enable the Good Known Host (GKH) values to make them 513 
Trusted. 514 

5.3.1 Add vCenter to HTCC 515 

In this step, you will add the hosts to HTCC. Since all the hosts are managed by vCenter (as compared to 516 
standalone ESX hosts), you will add vCenter as the host—that will automatically detect the NSX server 517 
and the ESX hosts, and add them to HTCC. The high-level steps are: 518 
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1. In HTCC, add vCenter as the host. For vCenter, use the same AD LDAP used for the HTCC vCenter 519 
AD id, ht_vcenter_svc@ibm.local (change the domain name based on what you have). While 520 
you can use Administrator@vsphere.local, best practice suggests you use the AD id. 521 

2. For all the ESX hosts that are detected, add their user ids/passwords and Publish IPs. 522 

3. If the vCenter and ESX host patch levels are not one of the valid patches supported by HTCC, add 523 
the patch level to HTCC so it recognizes them as valid hosts. 524 

5.3.2 Enable a Good Known Host 525 

Enabling a Good Known Host indicates that you know and trust the host, and allows CloudControl to use 526 
this host as a source for measurements when assessing other hosts with the same BIOS and hypervisor 527 
versions for trust. 528 

1. Select Compliance > Hosts. 529 

2. On the Hosts page, select the host that you want to modify and click Edit. 530 

3. On the Edit Host page, click the Trust Attestation tab. Note: The tab appears only after the TAS 531 
server has been setup and configured. 532 

4. Check the Good Known Host (BIOS and VMM) checkbox. Important: Do not enable more than 533 
one Good Known Host with the same BIOS and hypervisor versions. 534 

5. Optionally, click the Trusted button for the View Host Trust Attestation Report. 535 

6. A dump file of the Trust report opens in a separate page. 536 

7. Click OK to confirm your selection. 537 

8. Click OK. 538 

9. The Good Known Host icon (green) displays next to the host name. You can mouse over the icon 539 
to see the host BIOS and hypervisor versions.  540 

Once a Good Known Host is enabled, all other hosts under the same vCenter with the same BIOS and 541 
hypervisor versions are automatically marked as trusted if their measurements match. A Good Known 542 
Host must be enabled for each different BIOS and hypervisor version of your hosts. 543 

5.3.3 Verify and update host trust 544 

CloudControl enables you to verify and update the host trust information by performing a complete 545 
attestation cycle consisting of registering, creating whitelists, and updating Trust status. You can use 546 
one of the following methods: 547 

 Manually select the hosts and click the Update Trust button. 548 

 Enable the Refresh Trust Status scheduled event. For more information on scheduled events, 549 
see the Administration Guide for HyTrust CloudControl. 550 
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Important: Because CloudControl requires all Good Known Hosts to be verified by both BIOS and VMM, 551 
you must run the Refresh Trust Status scheduled event when upgrading to ensure that all qualifications 552 
are met. Good Known Hosts from previous versions will not display the Good Known Host icon until 553 
verified. 554 

CloudControl automatically detects and updates the Trust Status of all Intel TXT ESXi hosts on boot. To 555 
manually verify and update host trust: 556 

1. Select Compliance > Hosts. 557 

2. On the Hosts page, select the ESXi or KVM host(s) that you want to validate and click Update 558 
Trust. 559 

Trusted hosts display the Trusted Host icon, and the TRUSTED policy label appears in the resource tree 560 
for the host. If a host is not trusted, the Untrusted Host icon is displayed. 561 

5.3.4 Define PolicyTags in CloudControl 562 

Use HyTrust CloudControl to define PolicyTags and assign them to hosts. 563 

1. Select Policy > PolicyTags. 564 

2. On the PolicyTags page, click Add. 565 

3. On the Add PolicyTag page, choose the PolicyTag Type and enter the appropriate value. 566 

a. Country: Assign Country Names 567 

b. State/Province: Assign State/Province 568 

c. Physical Data Center (PDC): Assign Physical Data Center name or region 569 

d. Region (Logical): Assign a geographical region 570 

e. Classification: Assign custom PolicyTags value 571 

4. Click OK. 572 

5. The PolicyTags page displays the PolicyTag that you added. Click Add to add another PolicyTag. 573 

5.3.5 Assign PolicyTags to hosts 574 

Important: We recommend that you put your host in maintenance mode before assigning PolicyTags, 575 
especially if you are modifying existing PolicyTag assignments which may be in use by your existing 576 
compliance rules. Do not remove the host from maintenance mode until you have verified that the new 577 
PolicyTag assignment has been correctly provisioned. 578 

1. Select Compliance > Hosts. 579 

2. On the Hosts page, check the checkbox for the Intel TXT-enabled host and click Edit. 580 
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3. On the Edit Hosts page, select the PolicyTag tab. 581 

4. Select the appropriate PolicyTag value for one or more of the fields listed in Section 5.3.4. 582 

5. Click OK. 583 

6. CloudControl displays a JGrowl error message that prompts users to PXE boot the host(s) to 584 
activate the PolicyTag assignment. 585 

5.3.6 Provision PolicyTags 586 

1. Collect the UUID information for each Trusted host. See Section 5.3.6.1. 587 

2. Generate and run the esxcli commands for hardware provisioning for each Trusted host. See 588 
Section 5.3.6.2 and Section 5.3.6.3. 589 

3. Verify that the PolicyTags are provisioned. See Section 5.3.6.4. 590 

5.3.6.1    Collect UUIDs of GKH and Trusted hosts 591 

The UUID information for the GKH and Trusted hosts can be collected from the vCenter MOB. You will 592 
need to obtain the UUID for each GKH and Trusted host. 593 

1. Log into the vCenter MOB at https://<VSPHERE_URL>/mob 594 

2. Perform the following series of page selections to reach the host page for each of your Intel TXT-595 
enabled hosts: 596 

 

3. On the Hosts page, click Summary. 597 

4. On the Summary page, click Hardware. The hardware page contains the UUID information. 598 

5. Repeat this for each Trusted host. 599 
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5.3.6.2   Generate esxcli commands 600 

Use the CloudControl cli to generate esxcli commands that can be used for hardware provisioning. 601 

1. Log into CloudControl as the ascadminuser, and run the following command: 602 

asc tas --export-certs 603 

This generates a file in /tmp in the following format: export--xxxx-xx-xxx.tgz 604 

2. Navigate to the /tmp folder and extract the file using the following command: 605 

tar -xvf export--xxxx-xx-xxx.tgz 606 

The extraction process lists several files, including the sha1.bin for each Trusted ESXi host. 607 

Example: 608 

export--2018-08-27T23-44-43Z/6aa6af76/14f6/42e8/b452/6aa6af76-14f6-42e8-b452-609 
dc27fe259e1a/system--6aa6af76-14f6-42e8-b452-dc27fe259e1a.der 610 

export--2018-08-27T23-44-43Z/6aa6af76/14f6/42e8/b452/6aa6af76-14f6-42e8-b452-611 
dc27fe259e1a/system--6aa6af76-14f6-42e8-b452-dc27fe259e1a.sha1.bin 612 

export--2018-08-27T23-44-43Z/6aa6af76/14f6/42e8/b452/6aa6af76-14f6-42e8-b452-613 
dc27fe259e1a/system--6aa6af76-14f6-42e8-b452-dc27fe259e1a.sha256.bin 614 

export--2018-08-27T23-44-43Z/6aa6af76/14f6/42e8/b452/6aa6af76-14f6-42e8-b452-615 
dc27fe259e1a/system--6aa6af76-14f6-42e8-b452-dc27fe259e1a.metadata.txt 616 

export--2018-08-27T23-44-43Z/dddfda66/314e/4378/8f4d/dddfda66-314e-4378-8f4d-617 
060b5d885038/system--dddfda66-314e-4378-8f4d-060b5d885038.der 618 

export--2018-08-27T23-44-43Z/dddfda66/314e/4378/8f4d/dddfda66-314e-4378-8f4d-619 
060b5d885038/system--dddfda66-314e-4378-8f4d-060b5d885038.sha1.bin 620 

export--2018-08-27T23-44-43Z/dddfda66/314e/4378/8f4d/dddfda66-314e-4378-8f4d-621 
060b5d885038/system--dddfda66-314e-4378-8f4d-060b5d885038.sha256.bin 622 

export--2018-08-27T23-44-43Z/dddfda66/314e/4378/8f4d/dddfda66-314e-4378-8f4d-623 
060b5d885038/system--dddfda66-314e-4378-8f4d-060b5d885038.metadata.txt 624 

3. Navigate to the extracted directory, for example: cd /tmp/export--xxxx-xx-xxx 625 

4. At the prompt, type the following command: 626 

grep -E -- '"(id|subject)" : ' json.dump | grep -A1 '<Trusted-627 
Host-UUID> ' 628 
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This command returns the “subject” and the “id”. 629 

Example: 630 

"subject" : "4c4c4544-0032-3010-8035-b5c04f333832", 631 

"id" : "6aa6af76-14f6-42e8-b452-dc27fe259e1a" 632 

5. Run the following command for each Trusted host: 633 

hexdump -e '"esxcli hardware tpm tag set --data=" 20/1 "%1.2x" 634 
";\n"' <sha1.bin file path> 635 

where <sha1.bin file path> matches the “id” for the specific host 636 

This returns the esxcli command. 637 

Example: 638 

hexdump -e '"esxcli hardware tpm tag set --data=" 20/1 "%1.2x" ";\n"' 639 

6aa6af76/14f6/42e8/b452/6aa6af76-14f6-42e8-b452-dc27fe259e1a/system--6aa6af76-14f6-640 
42e8-b452-dc27fe259e1a.sha1.bin 641 

esxcli hardware tpm tag set --data=46f048ce41afdfa686e4c00f9fd67a2b71d1c749; 642 

5.3.6.3   Run esxcli commands 643 

Run the esxcli commands for each Trusted host to provision the hardware tags. 644 

1. Put the Trusted host into maintenance mode. 645 

2. Log in to the ESXi host as root. 646 

3. Run the specific esxcli command for the Trusted host. The command is part of the hexdump 647 
output. 648 

Example: 649 

esxcli hardware tpm tag set --data=46f048ce41afdfa686e4c00f9fd67a2b71d1c749; 650 

4. Restart the ESXi host. The host should still be in maintenance mode. 651 

5.3.6.4  Verify PolicyTags on provisioned hosts 652 

1. Open CloudControl and select Compliance > Hosts. 653 

2. Select the host that you just updated and click Update Trust. 654 

3. Select Policy > Resources. 655 
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4. Verify that the PolicyTags have been provisioned. If the tag icon next to the host being 656 
provisioned is blue, then the PolicyTags assigned to the host are provisioned. If the tag icon is 657 
yellow, then the PolicyTags assigned to the host are not provisioned. 658 

Note: If the provisioning process was not successful, you may have to clear the TPM once again 659 
and repeat the process. 660 

After the PolicyTag provisioning is successful, you can remove the hosts from maintenance mode. 661 

6 Intel Product Installation and Configuration Guide 662 

The aspects of installing and configuring the Intel products used to build the example solution have not 663 
yet been fully documented. The completed documentation is planned for inclusion in the next draft of 664 
this guide.  665 

7 RSA Product Installation and Configuration Guide 666 

The aspects of installing and configuring the RSA products used to build the example solution have not 667 
yet been fully documented. The completed documentation is planned for inclusion in the next draft of 668 
this guide.  669 

8 VMware Product Installation and Configuration Guide 670 

This section covers all the aspects of installing and configuring the VMware products used to build the 671 
example solution.  672 

8.1 Prerequisites 673 

The VMware Validated Design (VVD) is a blueprint for a Software Defined Data Center (SDDC). A 674 
Standard deployment model was used. In order to prepare for the implementation of the VVD, review 675 
the following documentation. It outlines the preparation and planning phases, contains logical design 676 
architectures and design decisions related to the implementation, and assists with the end-to-end 677 
process of deploying a VVD: 678 

 VMware Validated Design Documentation 679 

 Documentation Structure and Audience (VVD 4.3, VVD 5.0.1), see Figure 8-1 680 

o Architecture and Design 681 

o Planning and Preparation Deployment 682 

o Planning and Preparation Upgrade 683 

o Monitoring and Alerting 684 

https://docs.vmware.com/en/VMware-Validated-Design/index.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-introduction.doc/GUID-ECA36E0B-4952-4CD8-9C26-C0C21846AEFC.html
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-introduction.doc/GUID-ECA36E0B-4952-4CD8-9C26-C0C21846AEFC.html
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o Backup and Restore 685 

o Site Protection and Recovery 686 

o Certificate Replacement 687 

o Operational Verification 688 

o IT Automating IT 689 

o Intelligent Operations 690 

o Security and Compliance Configuration for NIST 800-53: 691 

 Introduction to Security and Compliance 692 

 Product Applicability Guide for NIST 800-53 693 

 Configuration for Compliance with NIST 800-53 694 

 Audit Compliance with NIST 800-53 695 

 Introducing VMware Validated Design for Software-Defined Data Center (VVD 4.3, VVD 5.0.1) 696 

 Design Objectives of VMware Validated Designs (VVD 4.3, VVD 5.0.1) 697 

 Overview of Standard SDDC (VVD 4.3, VVD 5.0.1) 698 

 VMware Validated Design Architecture and Design (VVD 4.3, VVD 5.0.1) 699 

 VMware Validated Design Planning and Preparation (VVD 4.3, VVD 5.0.1) 700 

 VMware Validated Design for Software-Defined Data Center Release Notes (VVD 4.3, VVD 5.0, 701 
VVD 5.0.1)  702 

To visualize how the VVD works in conjunction with the Compliance Kit for NIST 800-53, Figure 8-1 703 
provides an overview of the documentation structure. The VMware Validated Design Compliance Kit 704 
enhances the documentation of the VVD for SDDC and must be applied after the SDDC is deployed. 705 

https://docs.vmware.com/en/VMware-Validated-Design/services/introduction-to-security-and-compliance/GUID-DF1E96C3-BE0C-45CB-A3B8-CAB7AEA92962.html
https://docs.vmware.com/en/VMware-Validated-Design/5.1/vmware-validated-design-51-compliance-kit-nist-800-53.zip
https://docs.vmware.com/en/VMware-Validated-Design/5.1/sddc-security-and-compliance-configuration-guide-for-NIST-800-53/GUID-DD689D85-1E61-4BC8-93F4-76AA2A7AC11D.html
https://docs.vmware.com/en/VMware-Validated-Design/5.1/vmware-validated-design-51-compliance-kit-nist-800-53.zip
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-introduction.doc/GUID-A00FBD8D-A924-4DCA-B8EC-62BF33BEF5F2.html
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-introduction.doc/GUID-A00FBD8D-A924-4DCA-B8EC-62BF33BEF5F2.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-introduction.doc/GUID-C43C2F4B-E774-40AC-A3A4-D10BCE3CBA46.html
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-introduction.doc/GUID-C43C2F4B-E774-40AC-A3A4-D10BCE3CBA46.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-introduction.doc/GUID-DAD84411-B3CF-4F68-AD81-88E82EBEA5EA.html
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-introduction.doc/GUID-DAD84411-B3CF-4F68-AD81-88E82EBEA5EA.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-design.doc/GUID-44471514-D818-424F-AB32-57108003806C.html
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-design.doc/GUID-44471514-D818-424F-AB32-57108003806C.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-plan.doc/GUID-75126B85-2186-46F9-9EA0-00FC55451A1F.html
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-plan.doc/GUID-75126B85-2186-46F9-9EA0-00FC55451A1F.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/rn/vmware-validated-design-43-release-notes.html
https://docs.vmware.com/en/VMware-Validated-Design/5.0/rn/vmware-validated-design-50-release-notes.html
https://docs.vmware.com/en/VMware-Validated-Design/5.0.1/rn/vmware-validated-design-501-release-notes.html
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Figure 8-1: Map of VVD Documentation 706 
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To reconfigure your SDDC for compliance with NIST SP 800-53 [1], you must download and license 707 
additional VMware and third-party software. 708 

The VVD coupled with Security and Compliance Configuration for NIST 800-53 uses scripts and 709 
commands based on VMware PowerCLI to reconfigure the SDDC. You must prepare a host with a 710 
supported operating system (OS) for running Microsoft PowerShell, set up Microsoft PowerShell, and 711 
install the latest version of VMware PowerCLI. The host must have connectivity to the ESXi management 712 
network in the management cluster.  713 

8.2 Installation and Configuration 714 

Review the following documentation for the complete guide concerning the installation and 715 
configuration for the VVD for an SDDC for a Standard Deployment: 716 

 Deployment for Region A (VVD 4.3, VVD 5.0.1) 717 

 Deployment for Region B (VVD 4.3, VVD 5.0.1) 718 

8.3 Configuration Customization Supporting the Use Cases and Security 719 

Capabilities 720 

After deployment of a Standard VVD, the enhancements outlined in this publication should be applied. 721 
The security configurations and controls outlined in this section were implemented on a number of VVD 722 
versions, beginning with VVD 4.2 and then VVD 4.3. In addition to this lab, a separate project to publish 723 
the security configurations as a Compliance Kit that works as an enhancement to the VVD was published 724 
to VVD version 5.0.1. Changes between VVD 4.2, 4.3, 5.0.1, and even the most current version, 5.1, are 725 
unlikely to have a significant impact to the configuration guidance. 726 

Although this document outlines a specific version of the VVD, the Compliance Kit has been developed 727 
to support VVD 4.3, 5.0.1, 5.1, and future VVD releases. This section discusses the VMware Validated 728 
Design 5.0.1 Compliance Kit for NIST 800-53 and provides supplemental information detailing the 729 
resources that are included within the kit because the kit was not formally published for VVD 4.2 or 4.3, 730 
even though it was tested based on these versions. The VVD 5.0.1 Compliance Kit contains a number of 731 
files, including: 732 

 Introduction to Security and Compliance 733 

 Product Applicability Guide 734 

 Configuration Guide 735 

 Audit Guide 736 

 Audit Guide Appendix 737 

https://docs.vmware.com/en/VMware-Validated-Design/4.3/vmware-validated-design-43-sddc-regiona-deployment.pdf
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-deploya.doc/GUID-657DB777-D919-4C23-BA5E-B98D8A91CA8B.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/vmware-validated-design-43-sddc-regionb-deployment.pdf
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-deployb.doc/GUID-FB89668F-66DB-44BB-B9AC-AA206EDF1E5A.html
https://communities.vmware.com/thread/612305
https://communities.vmware.com/thread/612305


PRELIMINARY DRAFT 

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud IaaS Environments 38 

The configuration procedures included within the kit are in two groups: 738 

 Built-In Controls: Security controls based on compliance requirements are included in the VVD 739 
for SDDC. These may require configuration and adjustment, but by design the capabilities are 740 
included in the VVD for SDDC. 741 

 Enhanced Controls: Additional guidance on a per regulation or standard basis includes a set of 742 
capabilities that can be added to the VVD for SDDC. 743 

Over time, we expect a significant number of enhancement VVD controls to be incorporated into the 744 
VVD for SDDC. The enhancement guide always contains some number of NIST controls that are 745 
applicable to NIST SP 800-53 but are not included in the VVD for SDDC implementation. Each procedure 746 
documented in the Configuration Guide includes the NIST SP 800-53 control(s) that are associated with 747 
each. Two examples sampled from the Configuration Guide are included in Sections 8.3.1 and 8.3.2. 748 

Although the compliance kit was designed under VVD 5.0.1, the procedures and information included 749 
within the following sections are applicable to future releases of VVD, including VVD 5.1 and 5.1.1. 750 
Please note that while future iterations of the compliance kit will include configurations across all 751 
products, version 5.0.1 only corresponds to the following products: vCenter, ESXi, NSX for vSphere (NSX-752 
V), and vSAN. 753 

The following products are part of the VVD Bill of Materials, but not included in the current iteration of 754 
the Compliance Kit: vRealize, vRealize Automation (vRA), vRealize Operations Manager (vROPS), and 755 
vRealize Log Insight (vRLI). The documentation surrounding the configuration of these products does 756 
exist and is sourced from their respective DISA Security Technical Implementation Guides, which can be 757 
reviewed at https://public.cyber.mil/stigs/downloads. There are two examples for these configurations 758 
sampled from the Configuration Guide (Sections 8.3.3 and 8.3.4). 759 

8.3.1 Example VVD 5.0.1 Configuration: Configure the Password and Policy 760 
Lockout Setting in vCenter Server in Region A  761 

1. In a web browser, log into vCenter by using the vSphere Web Client. 762 

2. Configure the password policies. 763 

a. From the Home menu of the vSphere Web Client, click Administration. 764 

b. In the Navigator, under Single Sign-On, click Configuration.  765 

c. On the Policies tab, under Password Policy, click Edit. 766 

d. In the Edit Password Policies dialog box, configure the password policies and click OK. 767 

i. Maximum Lifetime should be set to 60. 768 

ii. Restrict Reuse should be set to 5. 769 

iii. Minimum Length should be set to 15.  770 

https://public.cyber.mil/stigs/downloads
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iv. Upper-case Characters should be set to 1. 771 

v. Lower-case Characters should be set to 1. 772 

vi. Numeric Characters should be set to 1. 773 

vii. Special Characters should be set to 1. 774 

3. Configure the lockout policies.  775 

a. On the Policies tab, click Lockout Policy and click Edit. 776 

b. In the Edit Lockout Policy dialog box, for Maximum Number of Failed Login Attempts, 777 
enter 3. 778 

c. For Interval Between Failures, enter 900. 779 

d. For Unlock Time, enter 0 and then click OK.  780 

8.3.2 Example VVD 5.0.1 Configuration: Configure Encryption Management in 781 
Region A  782 

1. In a web browser, log in to vCenter Server by using the vSphere Web Client. 783 

2. Enable Host Encryption Mode on the sfo01m01esx01.sfo01.rainpole.local host. 784 

a. From the Home menu of the vSphere Web Client, select Hosts and Clusters. 785 

b. Under the sfo01-m01dc data center, select the sfo01m01esx01.sfo01.rainpole.local host 786 
and click the Configure tab. 787 

c. Under System, click Security profile. 788 

d. Under Host Encryption Mode, click Edit. 789 

e. In the Set Encryption Mode dialog box, from the Encryption Mode drop-down menu, select 790 
Enabled and click OK. 791 

f. Repeat the procedure for all remaining hosts in Region A. 792 

3. Enable VM encryption on all the VMs and virtual disks. 793 

a. From the Home menu of the vSphere Web Client, select VMs and Templates. 794 

b. Under the sfo01-m01dc data center, expand the sfo01-m01fd-bcdr folder, right-click the 795 
sfo01m01vc01 VM and select VM Policies, then Edit VM Storage Policies. 796 

c. From the VM Storage Policy drop-down menu, select VM Encryption Policy, click Apply to 797 
all, and click OK. 798 

d. Repeat the procedure to reconfigure the remaining VMs in Region A. 799 
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8.3.3 Example vRealize Automation DISA STIG Configuration: Configure SLES for 800 
vRealize to protect the confidentiality and integrity of transmitted 801 
information 802 

1. Update the “Ciphers” directive with the following command: 803 

sed -i "/^[^#]*Ciphers/ c\Ciphers aes256-ctr,aes128-ctr" 804 
/etc/ssh/sshd_config 805 

2. Save and close the file. 806 

3. Restart the sshd process: 807 

service sshd restart 808 

8.3.4 Example vRealize Operations Manager DISA STIG Configuration: Configure 809 
the vRealize Operations server session timeout 810 

1. Logon to the admin UI as the administrator. 811 

2. Navigate to Global Settings. 812 

3. Select Edit Global Settings. 813 

4. Set the Session Timeout: setting to 15 minutes. 814 

5. Select OK. 815 

8.4 Operation, Monitoring, and Maintenance 816 

This section explains how to operate, monitor, and maintain various VMware products. It points to 817 
existing documentation whenever possible, so this document only includes supplemental information, 818 
such as backup and recovery processes, and specific monitoring practices recommended for the 819 
example solution. 820 

8.4.1 Operation  821 

This section discusses the basic operation of the VVD 5.0.1 for an SDDC, in addition to any relevant 822 
products associated with such operations. 823 

vSphere vCenter Server (vCS) Appliance is a management application that allows for the management of 824 
VMs and ESXi hosts centrally. The vSphere Web Client is used to access the vCS. 825 

vRealize Operations Manager (vROPS) tracks and analyzes the operation of multiple data sources in the 826 
SDDC by using specialized analytic algorithms. The algorithms help vROPS learn and predict the behavior 827 
of every object that it monitors. Users access this information by views, reports, and dashboards. 828 
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vRealize Automation (vRA) provides a secure web portal where authorized administrators, developers, 829 
and business owners can request new IT services and manage specific cloud and IT resources, while 830 
ensuring compliance with business policies.  831 

Please review the following for further information and discussion pertaining to the operational 832 
standards of the VVD 5.0.1 for an SDDC: VMware Validated Design Documentation, VMware Validated 833 
Design 5.0.1 Compliance Kit for NIST 800-53, and NIST SP 1800-19B. 834 

8.4.2 Monitoring  835 

This section outlines monitoring and alerting functionalities and best practices pertaining to VVD. 836 

Use the vRealize Log Insight (vRLI) event signature engine to monitor key events and to send filtered or 837 
tagged events to one or more remote destinations. You can use a set of alerts to send to vROPS and 838 
through SMTP for operations team notification. The use of vRLI allows you to monitor the SDDC and 839 
provide troubleshooting and cause analysis, which can reduce operating costs.  840 

With the integration between vRLI and vROPS, you can implement the following cross-product event 841 
tracking: 842 

 Send alerts from vRLI to vROPS, which maps them to the target objects. 843 

 Launch in context from a vROPS object to the objects logs in vRLI. 844 

 Launch in context from a vRLI event to the objects in vROPS. 845 

Use applications in vROPS to group monitoring data about the virtual machines of the SDDC 846 
management components. 847 

vROPS builds an application to determine how your environment is affected when one or more 848 
components experience problems. You can also monitor the overall health and performance of the 849 
application. 850 

vROPS collects data from the components in the application and displays the results in a summary 851 
dashboard with a real-time analysis for any or all the components. 852 

Ensuring that your backup solution is configured to trigger an email alert generation showing the status 853 
of your backup jobs is a recommended practice within the SDDC. This should be included in daily 854 
monitoring activities to ensure that all management objects within the SDDC have successful backup 855 
images. The following can be done to enable broad monitoring using vROPS: 856 

1. Create applications in vROPS to group the monitoring data 857 

a. about the VMs of vRealize Suite Lifecycle Manager 858 

b. about the VMs of vRLI 859 

https://docs.vmware.com/en/VMware-Validated-Design/index.html
https://communities.vmware.com/thread/612305
https://communities.vmware.com/thread/612305
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c. about the VMs of VMware Site Recovery Manager 860 

d. about the VMs of VMware vSphere Replication (vR) 861 

e. for the VMs of vROPS  862 

f. collected from your vSphere Storage APIs for Data Protection (VADP)-based backup solution 863 
VMs 864 

g. about the VMs of VMware vSphere Update Manager Download Service (UMDS) 865 

2. Create email notifications in vROPS so it informs the SDDC operators of issues in the main 866 
monitoring parameters of the environment. 867 

3. Configure vROPS to send email notifications about important alerts in the SDDC. 868 

Please review the Monitoring and Alerting documentation for more information regarding the 869 
monitoring of the VVD 4.3 deployment, and the VVD for SDDC 5.0.1 release notes for more information 870 
on monitoring for VVD 5.0.1 deployments.  871 

8.4.3 Maintenance   872 

This section outlines the steps to perform an SDDC upgrade that follows a defined upgrade path. The 873 
NCCoE project started with VVD version 4.3 and upgraded to 5.0.1. Table 8-1 provides a summary of the 874 
system requirements and upgrade sequence associated with the Bill of Materials (BOM) or product 875 
versions associated with each VVD version. This upgrade path is functional and defined by layers in 876 
which the components are upgraded or updated. It is important to note that functional and scalability 877 
tests for individual patches and express patches are not required for an environment. 878 

Table 8-1: Summary of VVD Version and Associated Bill of Materials (Product Versions) 879 

SDDC Layer Product Name Product Ver-
sion in VVD 4.3 

Product Ver-
sion in VVD 
5.0.1 

Operation 
Type 

Operations Man-
agement  

vRealize Suite Lifecycle Manager  1.2  2.0.0 Patch 2  Upgrade  

 vRealize Log Insight  4.6  4.7  Upgrade  

 vRealize Log Insight Agent  4.6  4.7  Upgrade  

 vRealize Operations Manager  6.7  7.0  Upgrade  

Cloud Manage-
ment  

vRealize Business for Cloud  7.4  7.5  Upgrade  

 vRealize Automation with Embed-
ded vRealize Orchestrator  

7.4  7.5  Upgrade  

https://docs.vmware.com/en/VMware-Validated-Design/4.3/vmware-validated-design-43-sddc-monitoring.pdf
https://docs.vmware.com/en/VMware-Validated-Design/5.0.1/rn/vmware-validated-design-501-release-notes.html?hWord=N4IghgNiBcIGoFsDuYBOBTABAN0gSwBMwAXdAzAEXQGc8BzAO0wFYA6ARhAF8g
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SDDC Layer Product Name Product Ver-
sion in VVD 4.3 

Product Ver-
sion in VVD 
5.0.1 

Operation 
Type 

Business Conti-
nuity  

Site Recovery Manager  6.5.1.1  8.1.1  Upgrade  

 vSphere Replication  6.5.1.3  8.1.1  Upgrade  

 
Backup solution based on VMware 
vSphere Storage APIs for Data Pro-
tection  

Compatible 
Version  

Compatible 
Version  

Vendor 
Specific  

Virtual Infrastruc-
ture  

NSX Data Center for vSphere  6.4.1  6.4.4  Update  

 Platform Services Controller  6.5 Update 2  6.7 Update 1  Upgrade  

 vCenter Server  6.5 Update 2  6.7 Update 1  Upgrade  

 vSphere Update Manager Down-
load Service  

6.5 Update 2  6.7 Update 1  Upgrade  

 ESXi  6.5 Update 2  6.7 Update 1  Upgrade  

 vSAN 6.6.1 Update 2 6.7 Update 1 Upgrade 
 

The following are tips for upgrading the SDDC: 880 

 Before you begin any upgrade process, review all the release notes.  881 

 Consider that the SDDC design and implementation may be affected by security features that 882 
are enabled. Ensure interoperability testing is performed before and after making security 883 
changes, as well as when introducing new features, functionality, and bug fixes. 884 

 The environment within the NCCoE lab varies from the traditional VVD deployment because for 885 
the NCCoE, additional integration with vendors is included, e.g., integration between HyTrust 886 
components and Key Management Server (KMS) and the VVD.  887 

 Note that if a distributed environment is used, ensure there is replication by using the 888 
vdcrepadmin command line interface between the platform services controller (PSC) and the 889 
vCenter environments. This can be checked by following the instructions in VMware Knowledge 890 
Base article 2127057. 891 

 Perform a backup copy of your current certificates before you start the upgrade process. If you 892 
need to request a new certificate, ensure you follow the procedures in this document for VVD 893 
4.3 and this document for VVD 5.1. 894 

https://kb.vmware.com/s/article/2127057
https://kb.vmware.com/s/article/2127057
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-certificate.doc/GUID-ADE495EB-117C-4FDA-AC3A-A42FD3FE25E9.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-certificate.doc/GUID-ADE495EB-117C-4FDA-AC3A-A42FD3FE25E9.html
https://docs.vmware.com/en/VMware-Validated-Design/5.1/sddc-certificate-replacement/GUID-FA99EBD8-CE1C-405A-96C8-7B5EA9F79D23.html
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The following is a tip for updating the SDDC: 895 

 Before performing an update, ensure an operational verification test is performed before and 896 
after the update. In most cases, updates should not impact the SDDC design and 897 
implementation (updates could include patches and bug fixes).  898 

Updates that are not validated by VVD should be approached with caution. 899 

 Scalability and functionality tests for individual patches, express patches, and hot fixes are not 900 
typically performed using the VVD. If a patch must be applied to your environment, follow the 901 
VMware published practices and VMware Knowledge Base articles for the specific patch. If an 902 
issue occurs during or after the process of applying a patch, contact VMware Technical Support. 903 

 For further information and instruction regarding an update, please see the following 904 
documentation for VVD 4.3 or VVD 5.0. 905 

8.5 Product Configuration Overview 906 

This section contains Table 8-2, which details all configurations for each product, their corresponding 907 
enhanced or built-in label, and their mapped NIST SP 800-53 Revision 4 control(s). The labels are 908 
derived from the compliance kit with the exception of the vRA and vROPS items, which are sourced 909 
directly from their corresponding DISA STIGs.  910 

There are only a small number of vROPS and vRA DISA STIGs included in the following table, which 911 
means it does not include all available configurations. For the entire compilation of vROPS and vRA DISA 912 
STIGs, please review the following links: 913 

 VMware vRealize Automation 7.x Lighttpd 914 

 VMware vRealize Automation 7.x SLES 915 

 VMware vRealize Automation 7.x tc Server  916 

 VMware vRealize Operations Manager 6.x Application  917 

 VMware vRealize Operations Manager 6.x SLES  918 

 VMware vRealize Operations Manager 6.x tc Server 919 

 VMware vRealize – Cassandra 920 

There are a few notable items for which there are no NIST control mappings; rather, they are identified 921 
as “VMware Best Practices”. These items are not sourced from any existing DISA STIGs, hardening 922 
guides, or other compliance frameworks. As such, they are only defined as “VMware Best Practices” and 923 
their implementation is strongly recommended. 924 

https://docs.vmware.com/en/VMware-Validated-Design/4.3/vmware-validated-design-43-sddc-upgrade.pdf
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-upgrade.doc/GUID-D97D5696-89F3-4425-97A4-3CE799C79532.html
https://www.stigviewer.com/stig/vmware_vrealize_automation_7.x_lighttpd/
https://www.stigviewer.com/stig/vmware_vrealize_automation_7.x_sles/
https://www.stigviewer.com/stig/vmware_vrealize_automation_7.x_tc_server/
https://www.stigviewer.com/stig/vmware_vrealize_operations_manager_6.x_application/
https://www.stigviewer.com/stig/vmware_vrealize_operations_manager_6.x_sles/
https://www.stigviewer.com/stig/vmware_vrealize_operations_manager_6.x_tc_server/
https://www.stigviewer.com/stig/vrealize_-_cassandra/
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Table 8-2: Configuration Items Without Control Mappings 925 

Product 
Name Configuration Label Enhanced 

or Built-in NIST SP 800-53 Rev. 4 Controls 

ESXi NIST80053-VI-ESXI-CFG-00048 Enhanced AC-12 

ESXi NIST80053-VI-ESXI-CFG-00146 Built-In AC-14a, AC-14b 

ESXi NIST80053-VI-ESXI-CFG-00031 Enhanced AC-17 

ESXi NIST80053-VI-ESXI-CFG-00165 Built-In AC-7 

ESXi NIST80053-VI-ESXI-CFG-00002 Enhanced AC-8 

NSX NIST80053-VI-NET-CFG-00343 Built-In CM-7 

NSX NIST80053-VI-NET-CFG-00344 Built-In CM-7 

NSX NIST80053-VI-NET-CFG-00372 Enhanced CP-9 

NSX NIST80053-VI-NET-CFG-00374 Enhanced CP-9 

NSX NIST80053-VI-NET-CFG-00312 Built-In IA-5 

vCenter NIST80053-VI-VC-CFG-00453 Built-In VMware Best Practice only. No spe-
cific UCF_NIST_800_53_R4_High con-
trol is associated with this capability. 

vCenter NIST80053-VI-VC-CFG-00465 Built-In VMware Best Practice only. No spe-
cific UCF_NIST_800_53_R4_High con-
trol is associated with this capability. 

vCenter NIST80053-VI-VC-CFG-00442 Enhanced AU-5(2) 

vCenter NIST80053-VI-VC-CFG-00461 Built-In AU-9, AU-6a, AU-2d, AC-6(9) 

vCenter NIST80053-VI-VC-CFG-00460 Built-In AU-9, AU-7b, AU-7a, AU-7(1), AU-6a, 
AU-12c, AU-12a, AC-6(9) 

vRA VRAU-TC-000710 Enhanced AC-17 (1) 

vRA VRAU-VA-000010 Enhanced AC-17 (2) 

vRA VRAU-HA-000140 Enhanced CM-7a 

vRA VRAU-LI-000215 Enhanced CM-7a 

vRA VRAU-SL-000360 Enhanced IA-5 (1) (b) 

vRA VRAU-VI-000240 Enhanced IA-5 (1) (c) 

vRA VRAU-AP-000265 Enhanced IA-7 

vRA VRAU-PG-000470 Enhanced SC-13 

vROPS VROM-CS-000005 Enhanced AC-3 

vROPS VROM-PG-000220 Enhanced IA-7 
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Product 
Name Configuration Label Enhanced 

or Built-in NIST SP 800-53 Rev. 4 Controls 

vROPS VROM-SL-001240 Enhanced SC-13 

vROPS VROM-TC-000505 Enhanced SC-2 

vSAN NIST80053-VI-Storage-SDS-CFG-00182 Built-In AC-11a 

vSAN NIST80053-VI-Storage-SDS-CFG-00186 Enhanced AU-4 

vSAN NIST80053-VI-Storage-SDS-CFG-00180 Built-In AU-8b, AU-8a, AU-8(1)(b), AU-8(1)(a) 

vSAN NIST80053-VI-Storage-SDS-CFG-00181 Built-In AU-9, AU-7b, AU-7a, AU-7(1), AU-6a, 
AU-12c, AU-12a, AC-6(9) 

vSAN NIST80053-VI-Storage-SDS-CFG-00183 Enhanced SC-13, MP-5(4), AU-9(3) 

vSphere NIST80053-VI-VSPHERE-CFG-00571 Enhanced CM-6 

vSphere NIST80053-VI-VSPHERE-CFG-00563  Enhanced IA-2 
926 
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Appendix A Security Configuration Setting Mappings 927 

This appendix captures the security configuration settings (Common Configuration Enumerations [CCEs]), which are mapped to 928 
the associated NIST SP 800-53 [1] controls and NIST Cybersecurity Framework [2] subcategories. The settings have not yet been 929 
fully inventoried. The completed mappings are planned for inclusion in the next draft of this guide. 930 

The following table lists the VMware products and their associated security configurations. 931 

CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8440
1-9 

NIST800
53-VI-
ESXi-
CFG-
00001 

Enhanc
ed 

ESXi Connect via SSH and run the following command: 
 
# grep -i "^Ciphers" /etc/ssh/sshd_config 
 
If there is no output or the output is not “Ciphers aes128-
ctr,aes192-ctr,aes256-ctr,aes128-cbc,aes192-cbc,aes256-cbc” or 
a subset of this list, ciphers that are not FIPS-approved are in use, 
so this is a finding. 

aes128-ctr,aes192-
ctr,aes256-
ctr,aes128-
cbc,aes192-
cbc,aes256-cbc 

CCE-
8440
2-7 

NIST800
53-VI-
ESXi-
CFG-
00002 

Enhanc
ed 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^Protocol" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “Protocol 2”, this 
is a finding. 

2 

CCE-
8440
3-5 

NIST800
53-VI-
ESXi-
CFG-
00003 

Enhanc
ed 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^IgnoreRhosts" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “IgnoreRhosts 
yes”, this is a finding. 

yes 

CCE-
8440
4-3 

NIST800
53-VI-
ESXi-

Enhanc
ed 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^HostbasedAuthentication" /etc/ssh/sshd_config 

no 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CFG-
00004 

 
If there is no output or the output is not exactly “HostbasedAu-
thentication no”, this is a finding. 

CCE-
8440
5-0 

NIST800
53-VI-
ESXi-
CFG-
00005 

Enhanc
ed 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^PermitRootLogin" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “PermitRoot-
Login no”, this is a finding. 

no 

CCE-
8440
6-8 

NIST800
53-VI-
ESXi-
CFG-
00006 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^PermitEmptyPasswords" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “PermitEmpty-
Passwords no”, this is a finding. 

no 

CCE-
8440
7-6 

NIST800
53-VI-
ESXi-
CFG-
00007 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^PermitUserEnvironment" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “PermitUserEnvi-
ronment no”, this is a finding. 

no 

CCE-
8440
8-4 

NIST800
53-VI-
ESXi-
CFG-
00008 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^MACs" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “MACs hmac-
sha1,hmac-sha2-256,hmac-sha2-512”, this is a finding. 

hmac-sha1,hmac-
sha2-256,hmac-
sha2-512 

CCE-
8440
9-2 

NIST800
53-VI-
ESXi-

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^GSSAPIAuthentication" /etc/ssh/sshd_config 
 

no 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CFG-
00009 

If there is no output or the output is not exactly “GSSAPIAuthen-
tication no”, this is a finding. 

CCE-
8441
0-0 

NIST800
53-VI-
ESXi-
CFG-
00010 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^KerberosAuthentication" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “Kerber-
osAuthentication no”, this is a finding. 

no 

CCE-
8441
1-8 

NIST800
53-VI-
ESXi-
CFG-
00011 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^StrictModes" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “StrictModes 
yes”, this is a finding. 

yes 

CCE-
8441
2-6 

NIST800
53-VI-
ESXi-
CFG-
00012 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^Compression" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “Compression 
no”, this is a finding. 

no 

CCE-
8441
3-4 

NIST800
53-VI-
ESXi-
CFG-
00013 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^GatewayPorts" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “GatewayPorts 
no”, this is a finding. 

no 

CCE-
8441
4-2 

NIST800
53-VI-
ESXi-
CFG-
00014 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^X11Forwarding" /etc/ssh/sshd_config 
 

no 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

If there is no output or the output is not exactly “X11Forwarding 
no”, this is a finding. 

CCE-
8441
5-9 

NIST800
53-VI-
ESXi-
CFG-
00015 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^AcceptEnv" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “AcceptEnv”, this 
is a finding. 

AcceptEnv 

CCE-
8441
6-7 

NIST800
53-VI-
ESXi-
CFG-
00016 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^PermitTunnel" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “PermitTunnel 
no”, this is a finding. 

no 

CCE-
8441
7-5 

NIST800
53-VI-
ESXi-
CFG-
00017 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^ClientAliveCountMax" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly 
“ClientAliveCountMax 3”, this is a finding. 

3 

CCE-
8441
8-3 

NIST800
53-VI-
ESXi-
CFG-
00018 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^ClientAliveInterval" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly 
“ClientAliveInterval 200”, this is a finding. 

200 

CCE-
8441
9-1 

NIST800
53-VI-
ESXi-
CFG-
00019 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^MaxSessions" /etc/ssh/sshd_config 
 

1 



PRELIMINARY DRAFT 

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud IaaS Environments 51 

CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

If there is no output or the output is not exactly “MaxSessions 1”, 
this is a finding. 

CCE-
8442
0-9 

NIST800
53-VI-
ESXi-
CFG-
00020 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^Ciphers" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “Ciphers aes128-
ctr,aes192-ctr,aes256-ctr,aes128-cbc,aes192-cbc,aes256-cbc”, ci-
phers that are not FIPS-approved may be used, so this is a find-
ing. 

aes128-ctr,aes192-
ctr,aes256-
ctr,aes128-
cbc,aes192-cbc, 
aes256-cbc 

CCE-
8442
1-7 

NIST800
53-VI-
ESXi-
CFG-
00022 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Security.PasswordQualityControl 
 
If Security.PasswordQualityControl is not set to “similar=deny 
retry=3 min=disabled,disabled,disabled,disabled,15”, this is a 
finding. 

similar=deny retry=3 
min=disabled,disa-
bled,disabled,disa-
bled,15 

CCE-
8442
2-5 

NIST800
53-VI-
ESXi-
CFG-
00028 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostFirewallException | Where {$_.Name -
eq 'SSH Server' -and $_.Enabled -eq $true} | Select 
Name,Enabled,@{N="AllIPEnabled";E={$_.ExtensionData.Allowed
Hosts.AllIP}} 
 
If for an enabled service “Allow connections from any IP address” 
is selected, this is a finding. 

AllIPEnabled: False 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8442
3-3 

NIST800
53-VI-
ESXi-
CFG-
00030 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
UserVars.SuppressShellWarning 
 
If UserVars.SuppressShellWarning is not set to 0, this is a finding. 

0 

CCE-
8442
4-1 

NIST800
53-VI-
ESXi-
CFG-
00031 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Select 
Name,@{N="Lockdown";E={$_.Extensiondata.Config.LockdownM
ode}} 
 
If Lockdown Mode is disabled, this is a finding.   
 
For environments that do not use vCenter server to manage ESXi, 
this is not applicable. 

lockdownNormal 

CCE-
8442
5-8 

NIST800
53-VI-
ESXi-
CFG-
00034 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Security.AccountLockFailures 
 
If Security.AccountLockFailures is not set to 3, this is a finding. 

3 

CCE-
8442
6-6 

NIST800
53-VI-
ESXi-
CFG-
00038 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
UserVars.ESXiShellInteractiveTimeOut 
 

600 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

If UserVars.ESXiShellInteractiveTimeOut is not set to 600, this is a 
finding. 

CCE-
8442
7-4 

NIST800
53-VI-
ESXi-
CFG-
00039 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
UserVars.ESXiShellTimeOut 
 
If UserVars.ESXiShellTimeOut is not set to 600, this is a finding. 

600 

CCE-
8442
8-2 

NIST800
53-VI-
ESXi-
CFG-
00043 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Net.BlockGuestBPDU 
 
If Net.BlockGuestBPDU is not set to 1, this is a finding. 

1 

CCE-
8442
9-0 

NIST800
53-VI-
ESXi-
CFG-
00056 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 
$esxcli = Get-EsxCli 
$esxcli.system.coredump.network.get() 
 
If there is no active core dump partition or the network core 
dump collector is not configured and enabled, this is a finding. 

TRUE 

CCE-
8443
0-8 

NIST800
53-VI-
ESXi-
CFG-
00106 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHostFirewallDefaultPolicy 
 
If the Incoming or Outgoing policies are True, this is a finding. 

FALSE 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8443
1-6 

NIST800
53-VI-
ESXi-
CFG-
00107 

En-
hanced 

ESXi Log in to the host and run the following command:  
 
# ls -la /etc/ssh/keys-root/authorized_keys 
 
If the authorized_keys file exists, this is a finding. 

File should not exist 

CCE-
8443
2-4 

NIST800
53-VI-
ESXi-
CFG-
00108 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHostSnmp | Select * 
 
or 
 
From a console or ssh session run the following command: 
 
esxcli system snmp get 
 
If SNMP is not in use and is enabled, this is a finding. 
 
If SNMP is enabled and “read only communities” is set to public, 
this is a finding. 
 
If SNMP is enabled and is not using v3 targets, this is a finding. 
 
Note: SNMP v3 targets can only be viewed and configured from 
the esxcli command. 

FALSE 

CCE-
8443
3-2 

NIST800
53-VI-
ESXi-
CFG-
00109 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^password" /etc/pam.d/passwd | grep sufficient 
 
If the remember setting is not set or is not “remember=5”, this is 
a finding. 

remember=5 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8443
4-0 

NIST800
53-VI-
ESXi-
CFG-
00110 

Built-in ESXi Run the following command:  
 
# grep -i "^password" /etc/pam.d/passwd | grep sufficient 
 
If sha512 is not listed, this is a finding. 

sha512 

CCE-
8443
5-7 

NIST800
53-VI-
ESXi-
CFG-
00111 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostService | Where {$_.Label -eq "SSH"} 
 
If the ESXi SSH service is running, this is a finding. 

Policy: Off and Run-
ning: False 

CCE-
8443
6-5 

NIST800
53-VI-
ESXi-
CFG-
00112 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostService | Where {$_.Label -eq "ESXi 
Shell"} 
 
If the ESXi Shell service is running, this is a finding. 

Policy: Off and Run-
ning: False 

CCE-
8443
7-3 

NIST800
53-VI-
ESXi-
CFG-
00113 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostService | Where {$_.Label -eq "SSH"} 
 
If the ESXi SSH service is running, this is a finding. 

Policy: Off and Run-
ning: False 

CCE-
8443
8-1 

NIST800
53-VI-
ESXi-
CFG-
00114 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostAuthentication 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 

sfo01.rainpole.local 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If Directory Services Type is not set to “Active Directory”, this is a 
finding. 

CCE-
8443
9-9 

NIST800
53-VI-
ESXi-
CFG-
00115 

Built-in ESXi From a PowerCLI command prompt, while connected to vCenter 
run the following command: 
 
Get-VMHost | Select Name, ` @{N="HostProfile";E={$_ | Get-
VMHostProfile}}, ` @{N="JoinADEnabled";E={($_ | Get-
VmHostProfile).ExtensionData.Config.ApplyProfile.Authentication
.ActiveDirectory.Enabled}}, ` @{N="JoinDomainMethod";E={(($_ 
| Get-
VMHostProfile).ExtensionData.Config.ApplyProfile.Authenticatio
n.ActiveDirectory | Select -ExpandProperty Policy | Where {$_.Id 
-eq "JoinDomainMethodPolicy"}).Policyoption.Id}} 
 
Verify if "JoinADEnabled" is "True" then "JoinDomainMethod" 
should be "FixedCAMConfigOption". 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 

JoinADEnabled: 
True, JoinDomain-
Method: Fixed-
CAMConfigOption 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

If vSphere Authentication Proxy is not used to join hosts to an 
Active Directory domain, this is a finding. 

CCE-
8444
0-7 

NIST800
53-VI-
ESXi-
CFG-
00116 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostAuthentication 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If the Directory Services Type is not set to “Active Directory”, this 
is a finding. 

sfo01.rainpole.local 

CCE-
8444
1-5 

NIST800
53-VI-
ESXi-
CFG-
00117 

Built-in ESXi From a PowerCLI command prompt, while connected to vCenter 
run the following command: 
 
Get-VMHost | Select Name, ` @{N="HostProfile";E={$_ | Get-
VMHostProfile}}, ` @{N="JoinADEnabled";E={($_ | Get-
VmHostProfile).ExtensionData.Config.ApplyProfile.Authentication
.ActiveDirectory.Enabled}}, ` @{N="JoinDomainMethod";E={(($_ 
| Get-
VMHostProfile).ExtensionData.Config.ApplyProfile.Authenticatio
n.ActiveDirectory | Select -ExpandProperty Policy | Where {$_.Id 
-eq "JoinDomainMethodPolicy"}).Policyoption.Id}} 
 
Verify if "JoinADEnabled" is "True" then "JoinDomainMethod" 
should be "FixedCAMConfigOption". 

sfo01.rainpole.local 
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For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If vSphere Authentication Proxy is not used to join hosts to an 
Active Directory domain, this is a finding. 

CCE-
8444
2-3 

NIST800
53-VI-
ESXi-
CFG-
00118 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostAuthentication 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If Directory Services Type is not set to “Active Directory”, this is a 
finding. 

sfo01.rainpole.local 

CCE-
8444
3-1 

NIST800
53-VI-
ESXi-
CFG-
00119 

Built-in ESXi From a PowerCLI command prompt, while connected to vCenter 
run the following command: 
 
Get-VMHost | Select Name, ` @{N="HostProfile";E={$_ | Get-
VMHostProfile}}, ` @{N="JoinADEnabled";E={($_ | Get-

sfo01.rainpole.local 
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VmHostProfile).ExtensionData.Config.ApplyProfile.Authentication
.ActiveDirectory.Enabled}}, ` @{N="JoinDomainMethod";E={(($_ 
| Get-
VMHostProfile).ExtensionData.Config.ApplyProfile.Authenticatio
n.ActiveDirectory | Select -ExpandProperty Policy | Where {$_.Id 
-eq "JoinDomainMethodPolicy"}).Policyoption.Id}} 
 
Verify if "JoinADEnabled" is "True" then "JoinDomainMethod" 
should be "FixedCAMConfigOption". 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If vSphere Authentication Proxy is not used to join hosts to an 
Active Directory domain, this is a finding. 

CCE-
8444
4-9 

NIST800
53-VI-
ESXi-
CFG-
00120 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostAuthentication 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 

sfo01.rainpole.local 
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finding. 
 
If Directory Services Type is not set to “Active Directory”, this is a 
finding. 

CCE-
8444
5-6 

NIST800
53-VI-
ESXi-
CFG-
00121 

Built-in ESXi From a PowerCLI command prompt, while connected to vCenter 
run the following command: 
 
Get-VMHost | Select Name, ` @{N="HostProfile";E={$_ | Get-
VMHostProfile}}, ` @{N="JoinADEnabled";E={($_ | Get-
VmHostProfile).ExtensionData.Config.ApplyProfile.Authentication
.ActiveDirectory.Enabled}}, ` @{N="JoinDomainMethod";E={(($_ 
| Get-
VMHostProfile).ExtensionData.Config.ApplyProfile.Authenticatio
n.ActiveDirectory | Select -ExpandProperty Policy | Where {$_.Id 
-eq "JoinDomainMethodPolicy"}).Policyoption.Id}} 
 
Verify if "JoinADEnabled" is "True" then "JoinDomainMethod" 
should be "FixedCAMConfigOption". 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If vSphere Authentication Proxy is not used to join hosts to an 
Active Directory domain, this is a finding. 

sfo01.rainpole.local 
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CCE-
8444
6-4 

NIST800
53-VI-
ESXi-
CFG-
00122 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Annotations.WelcomeMessage 
 
Check for the login banner text (mentioned in the parameter 
value) based on the character limitations imposed by the system. 
An exact match of the text is required. If this banner is not 
displayed, this is a finding. 

This system is for 
the use of author-
ized users only. Indi-
viduals using this 
computer system 
without authority or 
in excess of their au-
thority are subject 
to having all their 
activities on this sys-
tem monitored and 
recorded by system 
personnel. Anyone 
using this system ex-
pressly consents to 
such monitoring and 
is advised that if 
such monitoring re-
veals possible evi-
dence of criminal ac-
tivity system per-
sonal may provide 
the evidence of such 
monitoring to law 
enforcement offi-
cials. 

CCE-
8444
7-2 

NIST800
53-VI-
ESXi-
CFG-
00123 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Config.Etc.issue 
 

This system is for 
the use of author-
ized users only. Indi-
viduals using this 
computer system 
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If the Config.Etc.issue setting (/etc/issue file) does not contain 
the logon banner exactly as shown in the parameter value, this is 
a finding. 

without authority or 
in excess of their au-
thority are subject 
to having all their 
activities on this sys-
tem monitored and 
recorded by system 
personnel. Anyone 
using this system ex-
pressly consents to 
such monitoring and 
is advised that if 
such monitoring re-
veals possible evi-
dence of criminal ac-
tivity system per-
sonal may provide 
the evidence of such 
monitoring to law 
enforcement offi-
cials. 

CCE-
8444
8-0 

NIST800
53-VI-
ESXi-
CFG-
00124 

En-
hanced 

ESXi Connect via SSH and run the following command:  
 
# grep -i "^Banner" /etc/ssh/sshd_config 
 
If there is no output or the output is not exactly “Banner /etc/is-
sue”, this is a finding. 

This system is for 
the use of author-
ized users only. Indi-
viduals using this 
computer system 
without authority or 
in excess of their au-
thority are subject 
to having all their 
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activities on this sys-
tem monitored and 
recorded by system 
personnel. Anyone 
using this system ex-
pressly consents to 
such monitoring and 
is advised that if 
such monitoring re-
veals possible evi-
dence of criminal ac-
tivity system per-
sonal may provide 
the evidence of such 
monitoring to law 
enforcement offi-
cials. 

CCE-
8444
9-8 

NIST800
53-VI-
ESXi-
CFG-
00125 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following script: 
 
$vmhost = Get-VMHost | Get-View 
$lockdown = Get-View $vmhost.ConfigManager.HostAccessMan-
ager 
$lockdown.QueryLockdownExceptions() 
 
If the exception users list contains accounts that do not require 
special permissions, this is a finding. 
 
Note: This list is not intended for system administrator accounts 
but for special circumstances such as a service account. 

Remove unneces-
sary users from the 
exception user list 
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CCE-
8445
0-6 

NIST800
53-VI-
ESXi-
CFG-
00127 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Annotations.WelcomeMessage 
 
Check for the login banner text (mentioned in the parameter 
value) based on the character limitations imposed by the system. 
An exact match of the text is required. If this banner is not 
displayed, this is a finding. 

This system is for 
the use of author-
ized users only. Indi-
viduals using this 
computer system 
without authority or 
in excess of their au-
thority are subject 
to having all their 
activities on this sys-
tem monitored and 
recorded by system 
personnel. Anyone 
using this system ex-
pressly consents to 
such monitoring and 
is advised that if 
such monitoring re-
veals possible evi-
dence of criminal ac-
tivity system per-
sonal may provide 
the evidence of such 
monitoring to law 
enforcement offi-
cials. 

CCE-
8445
1-4 

NIST800
53-VI-
ESXi-
CFG-
00129 

En-
hanced 

ESXi If vCenter Update Manager is used on the network, it can scan all 
hosts for missing patches. From the vSphere Client, go to Hosts 
and Clusters >> Update Manager tab, and select Scan to view all 
hosts’ compliance status. 
 

Apply latest patches 
and updates 
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If vCenter Update Manager is not used, a host’s compliance sta-
tus must be manually determined by the build number. The fol-
lowing VMware KB 1014508 can be used to correlate patches 
with build numbers. 
 
If the ESXi host does not have the latest patches, this is a finding. 
 
If the ESXi host is not on a supported release, this is a finding. 

CCE-
8445
2-2 

NIST800
53-VI-
ESXi-
CFG-
00134 

En-
hanced 

ESXi The downloaded ISO, offline bundle, or patch hash must be veri-
fied against the vendor's checksum to ensure the integrity and 
authenticity of the files. See typical command line examples for 
both the md5 and sha1 hash checks: 
 
# md5sum <filename>.iso 
# sha1sum <filename>.iso 
 
If any of the system’s downloaded ISO, offline bundle, or system 
patch hashes cannot be verified against the vendor’s checksum, 
this is a finding. 

Compare the MD5 
sum output with the 
value posted on the 
VMware Web site. 
SHA1 or MD5 hash 
should match.  

CCE-
8445
3-0 

NIST800
53-VI-
ESXi-
CFG-
00135 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 

CCE-
8445
4-8 

NIST800
53-VI-
ESXi-
CFG-
00136 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logDir 

[] /scratch/log 
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If LocalLogOutputIsPersistent is not set to true, this is a finding. 

CCE-
8445
5-5 

NIST800
53-VI-
ESXi-
CFG-
00137 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Config.HostAgent.plugins.hostsvc.esxAdminsGroup 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If Config.HostAgent.plugins.hostsvc.esxAdminsGroup is set to 
“ESX Admins”, this is a finding. 

ug-SDDC-Admins 

CCE-
8445
6-3 

NIST800
53-VI-
ESXi-
CFG-
00138 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Mem.ShareForceSalting 
 
If Mem.ShareForceSalting is not set to 2, this is a finding. 

2 

CCE-
8445
7-1 

NIST800
53-VI-
ESXi-
CFG-
00139 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHostFirewallDefaultPolicy 
 
If the Incoming or Outgoing policies are True, this is a finding. 

N/A 
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CCE-
8445
8-9 

NIST800
53-VI-
ESXi-
CFG-
00141 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 

CCE-
8445
9-7 

NIST800
53-VI-
ESXi-
CFG-
00142 

En-
hanced 

ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Config.Hos-
tAgent.plugins.hostsvc.esxAdminsGroup 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If Config.HostAgent.plugins.hostsvc.esxAdminsGroup is set to 
“ESX Admins”, this is a finding. 

ug-SDDC-Admins 

CCE-
8446
0-5 

NIST800
53-VI-
ESXi-
CFG-
00143 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 
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CCE-
8446
1-3 

NIST800
53-VI-
ESXi-
CFG-
00145 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostNTPServer 
Get-VMHost | Get-VMHostService | Where {$_.Label -eq "NTP 
Daemon"} 
 
If the NTP service is not configured with authoritative DoD time 
sources and the service is not configured to start and stop with 
the host and is running, this is a finding. 

ntp.lax01.rain-
pole.local, 
ntp.sfo01.rain-
pole.local 

CCE-
8446
2-1 

NIST800
53-VI-
ESXi-
CFG-
00157 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 
$esxcli = Get-EsxCli 
$esxcli.software.acceptance.get() 
 
If the acceptance level is CommunitySupported, this is a finding. 

PartnerSupported 

CCE-
8446
3-9 

NIST800
53-VI-
ESXi-
CFG-
00158 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 
$esxcli = Get-EsxCli 
$esxcli.software.acceptance.get() 
 
If the acceptance level is CommunitySupported, this is a finding. 

PartnerSupported 

CCE-
8446
4-7 

NIST800
53-VI-
ESXi-
CFG-
00159 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 
$esxcli = Get-EsxCli 
$esxcli.software.acceptance.get() 
 
If the acceptance level is CommunitySupported, this is a finding. 

PartnerSupported 
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CCE-
8446
5-4 

NIST800
53-VI-
ESXi-
CFG-
00160 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 
$esxcli = Get-EsxCli 
$esxcli.software.acceptance.get() 
 
If the acceptance level is CommunitySupported, this is a finding. 

PartnerSupported 

CCE-
8446
6-2 

NIST800
53-VI-
ESXi-
CFG-
00161 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 
Get-VDSwitch | Get-VDSecurityPolicy 
Get-VDPortGroup | Get-VDSecurityPolicy 
 
If Forged Transmits is set to accept, this is a finding. 

FALSE 

CCE-
8446
7-0 

NIST800
53-VI-
ESXi-
CFG-
00162 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 
Get-VDSwitch | Get-VDSecurityPolicy 
Get-VDPortGroup | Get-VDSecurityPolicy 
 
If MAC Address Changes is set to accept, this is a finding. 

FALSE 

CCE-
8446
8-8 

NIST800
53-VI-
ESXi-
CFG-
00163 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name DCUI.Access 
 
If DCUI.Access is not restricted to root, this is a finding. 
 
Note: This list is only for local user accounts and should only con-
tain the root user. 

root 
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CCE-
8446
9-6 

NIST800
53-VI-
ESXi-
CFG-
00164 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 

CCE-
8447
0-4 

NIST800
53-VI-
ESXi-
CFG-
00165 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Security.AccountUnlockTime  
 
If Security.AccountUnlockTime is not set to 900, this is a finding. 

900 

CCE-
8447
1-2 

NIST800
53-VI-
ESXi-
CFG-
00166 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Config.HostAgent.plugins.solo.enableMob 
 
If Config.HostAgent.plugins.solo.enableMob is not set to false, 
this is a finding. 

FALSE 

CCE-
8447
2-0 

NIST800
53-VI-
ESXi-
CFG-
00167 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Config.HostAgent.plugins.hostsvc.esxAdminsGroup 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 

ug-SDDC-Admins 
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For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If Config.HostAgent.plugins.hostsvc.esxAdminsGroup is set to 
“ESX Admins”, this is a finding. 

CCE-
8447
3-8 

NIST800
53-VI-
ESXi-
CFG-
00168 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name UserVars.Dcui-
TimeOut 
 
If UserVars.DcuiTimeOut is not set to 600, this is a finding. 

600 

CCE-
8447
4-6 

NIST800
53-VI-
ESXi-
CFG-
00169 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Net.DVFilterBindIpAddress 
 
If Net.DVFilterBindIpAddress is not blank and security appliances 
are not in use on the host, this is a finding. 

"" 

CCE-
8447
5-3 

NIST800
53-VI-
ESXi-
CFG-
00170 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 
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CCE-
8447
6-1 

NIST800
53-VI-
ESXi-
CFG-
00171 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name UserVars.Dcui-
TimeOut 
 
If UserVars.DcuiTimeOut is not set to 600, this is a finding. 

600 

CCE-
8447
7-9 

NIST800
53-VI-
ESXi-
CFG-
00172 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 

CCE-
8447
8-7 

NIST800
53-VI-
ESXi-
CFG-
00173 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Config.HostAgent.plugins.hostsvc.esxAdminsGroup 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If the Config.HostAgent.plugins.hostsvc.esxAdminsGroup 
keyword is set to “ESX Admins”, this is a finding. 

ug-SDDC-Admins 
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CCE-
8447
9-5 

NIST800
53-VI-
ESXi-
CFG-
00174 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 

CCE-
8448
0-3 

NIST800
53-VI-
ESXi-
CFG-
00175 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Config.HostAgent.plugins.hostsvc.esxAdminsGroup 
 
For systems that do not use Active Directory and have no local 
user accounts, other than root, dcui, and/or vpxuser, this is not 
applicable. 
 
For systems that do not use Active Directory and do have local 
user accounts, other than root, dcui, and/or vpxuser, this is a 
finding. 
 
If Config.HostAgent.plugins.hostsvc.esxAdminsGroup is set to 
“ESX Admins”, this is a finding. 

ug-SDDC-Admins 

CCE-
8448
1-1 

NIST800
53-VI-
ESXi-
CFG-
00176 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 
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uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8448
2-9 

NIST800
53-VI-
ESXi-
CFG-
00177 

Built-in ESXi The vMotion VMkernel port group should be in a dedicated VLAN 
that can be on a common standard or distributed virtual switch 
as long as the vMotion VLAN is not shared by any other function 
and it is not routed to anything but ESXi hosts. The check for this 
will be unique per environment.  
 
From the vSphere Client, select the ESXi host and go to Configure 
> Networking > VMKernel adapters. Review the VLANs associated 
with the vMotion VMkernel(s) and verify they are dedicated for 
that purpose and logically separated from other functions. 
 
If long distance or cross vCenter vMotion is used, the vMotion 
network can be routable but must be accessible to only the in-
tended ESXi hosts. 
 
If the vMotion port group is not on an isolated VLAN and/or is 
routable to systems other than ESXi hosts, this is a finding. 
 
For environments that do not use vCenter Server to manage ESXi, 
this is not applicable. 

vMotion VMKernel 
Port group should 
be in a dedicated 
VLAN. The check for 
this will be unique 
per environment. 

CCE-
8448
3-7 

NIST800
53-VI-
ESXi-
CFG-
00178 

Built-in ESXi The Management VMkernel port group should be in a dedicated 
VLAN that can be on a common standard or distributed virtual 
switch as long as the Management VLAN is not shared by any 
other function and it is not routed to anything other than man-
agement related functions such as vCenter. The check for this will 
be unique per environment.   
 
From the vSphere Client, select the ESXi host and go to Configure 
> Networking > VMKernel adapters. Review the VLANs associated 
with the Management VMkernel and verify they are dedicated 
for that purpose and logically separated from other functions. 

Management 
VMKernel Port 
group should be in a 
dedicated VLAN. The 
check for this will be 
unique per environ-
ment 
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ID 
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In/En-
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Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

 
If the network segment is routed, except to networks where 
other management-related entities are located such as vCenter, 
this is a finding. 
 
If production virtual machine traffic is routed to this network, this 
is a finding. 

CCE-
8448
4-5 

NIST800
53-VI-
ESXi-
CFG-
00179 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Config.HostAgent.log.level 
 
If Config.HostAgent.log.level is not set to info, this is a finding. 
 
Note: Verbose logging level is acceptable for troubleshooting 
purposes. 

info 

CCE-
8448
5-2 

NIST800
53-VI-
ESXi-
CFG-
00180 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
Config.HostAgent.log.level 
 
If Config.HostAgent.log.level is not set to info, this is a finding. 
 
Note: Verbose logging level is acceptable for troubleshooting 
purposes. 

info 

CCE-
8448
6-0 

NIST800
53-VI-
ESXi-

Built-in ESXi From the vSphere Client, select the ESXi Host and go to Configure 
>> Networking >> VMKernel adapters. Review each VMkernel 
adapter that is defined and ensure it is enabled for only one type 
of management traffic. 

N/A 
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CFG-
00181 

 
If any VMkernel is used for more than one type of management 
traffic, this is a finding. 

CCE-
8448
7-8 

NIST800
53-VI-
ESXi-
CFG-
00182 

Built-in ESXi From the vSphere Client, select the ESXi Host and go to Configure 
>> Networking >> TCP/IP Configuration. Review the default 
system TCP/IP stacks and verify they are configured with the 
appropriate IP address information. 
 
If any system TCP/IP stack is configured and not in use by a 
VMkernel adapter, this is a finding. 

N/A 

CCE-
8448
8-6 

NIST800
53-VI-
ESXi-
CFG-
00192 

Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-VMHostNTPServer 
Get-VMHost | Get-VMHostService | Where {$_.Label -eq "NTP 
Daemon"} 
 
If the NTP service is not configured with authoritative DoD time 
sources and the service is not configured to start and stop with 
the host and is running, this is a finding. 

Policy :On and Run-
ning: True 

CCE-
8448
9-4 

NIST800
53-VI-
ESXi-
CFG-
00184 

Built-in ESXi This check refers to an entity outside the physical scope of the 
ESXi server system. The configuration of upstream physical 
switches must be documented to ensure that spanning tree pro-
tocol is disabled and/or portfast is configured for all physical 
ports connected to ESXi hosts. Inspect the documentation and 
verify that the documentation is updated on a regular basis 
and/or whenever modifications are made to either ESXi hosts or 
the upstream physical switches. Alternatively, log in to the physi-
cal switch and verify that spanning tree protocol is disabled 
and/or portfast is configured for all physical ports connected to 
ESXi hosts. 

N/A 
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If the physical switch's spanning tree protocol is not disabled or 
portfast is not configured for all physical ports connected to ESXi 
hosts, this is a finding. 

CCE-
8450
1-6 

NIST800
53-VI-
NET-
CFG-
00251 

Built-in NSX From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Policies >> Password Policy.  

NSX Manager Appli-
ance - NSX Domain 
Service Account - 
Password (Depend-
ent on Customer 
Configurations) 

CCE-
8450
2-4 

NIST800
53-VI-
NET-
CFG-
00252 

Built-in NSX From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Policies >> Password Policy.  

Border Gateway 
Protocol Password 
(Dependent on Cus-
tomer Configura-
tions) 

CCE-
8450
3-2 

NIST800
53-VI-
NET-
CFG-
00253 

Built-in NSX From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Policies >> Password Policy.  

Universal Distrib-
uted Logical Router 
Password (Depend-
ent on Customer 
Configurations) 

CCE-
8450
4-0 

NIST800
53-VI-
NET-
CFG-
00281 

Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Backup & 
Restore. 
 
If “Audit Logs” or “System Events” are excluded (by default they 
are NOT excluded), this is a finding. 

Audit logs and Sys-
tem events are not 
excluded 

CCE-
8450
5-7 

NIST800
53-VI-
NET-
CFG-
00282 

Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Ap-
pliance Settings and look under General Network Settings.  
 
If IPv6 is configured, this is a finding. 

IPv6 should be disa-
bled 
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CCE-
8450
6-5 

NIST800
53-VI-
NET-
CFG-
00283 

Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Ap-
pliance Settings and look under DNS Servers. 
 
If IPv6 DNS is configured, this is a finding. 

IPv6 DNS should be 
disabled 

CCE-
8450
7-3 

NIST800
53-VI-
NET-
CFG-
00285 

Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Ap-
pliance Settings and look under Time Settings.  
 
If any the NTP Servers are not authorized or trusted, this is a find-
ing. 

1) Use at least three 
NTP servers from 
outside time sources 
-OR- 
2) Configure a few 
local NTP servers on 
a trusted network 
that in turn obtain 
their time from at 
least three outside 
time sources 

CCE-
8450
8-1 

NIST800
53-VI-
NET-
CFG-
00286 

Built-in NSX Log on to NSX Manager Virtual Appliance and go to Manage Ap-
pliance Settings. Verify syslog server configuration. 

Remote syslog 
server is configured. 

CCE-
8450
9-9 

NIST800
53-VI-
NET-
CFG-
00287 

Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Ap-
pliance Settings --> SSL Certificates. Click on the certificate and 
verify certificate details. 

1) Appropriate Is-
suer 
2) Correct certificate 
Type 
3) RSA Algorithm 
4) 2048 bits keys or 
higher 

CCE-
8451
0-7 

NIST800
53-VI-
NET-

Built-in NSX Assess the deployment and try to reach NSX manager being on 
standard network. The NSX manager should only be reachable 
using isolation mechanisms. 

No read or write 
permissions on 
backup directory 
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CFG-
00288 

CCE-
8451
1-5 

NIST800
53-VI-
NET-
CFG-
00289 

Built-in NSX Log in to the VMware vSphere environment and inspect which 
users have access permissions to NSX manager VA.  
 
If any user other than the intended administrator has access to 
the VA or is able to carry out any administrative actions on that 
VA, this is a finding. 

Procedural 

CCE-
8451
2-3 

NIST800
53-VI-
NET-
CFG-
00290 

Built-in NSX Log in to the SFTP server and navigate to backup directory.  
 
If the backup directory can be read or written to by users other 
than the backup user, this is a finding. 

No read or write 
permissions on 
backup directory 

CCE-
8451
3-1 

NIST800
53-VI-
NET-
CFG-
00291 

Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Ap-
pliance Settings and look under General network settings.  
 
If IPv4 DNS is not authorized or secure, this is a finding. 

IPv4 DNS is author-
ized and secure 

CCE-
8451
4-9 

NIST800
53-VI-
NET-
CFG-
00294 

Built-in NSX Log on to NSX Manager Virtual Appliance, then look under 
Backup & Restore. Verify “FTP Server settings”. 

FTP Server settings 
(Dependent on Cus-
tomer Configura-
tions) 

CCE-
8451
5-6 

NIST800
53-VI-
NET-
CFG-
00295 

Built-in NSX After downloading the media, use the MD5/SHA1 sum value to 
verify the integrity of the download. Compare the MD5/SHA1 
hash output with the value posted on the VMware secure web-
site. 
 
If the hash output does not match the website value, this is a 
finding. 

SHA1 or MD5 hash 
should match  
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CCE-
8451
6-4 

NIST800
53-VI-
NET-
CFG-
00296 

Built-in NSX If the controller network is not deployed on a network that is not 
configured for or connected to other types of traffic, this is a find-
ing. 

Procedural (Depend-
ent on Customer 
Configurations) 

CCE-
8451
7-2 

NIST800
53-VI-
NET-
CFG-
00297 

Built-in NSX Run this Rest API call to get the properties of the controller node:  
 
https://<nsxmgr>/api/2.0/vdn/controller/node 
 
Response: 
<controllerNodeConfig> 
<ipSecEnabled>true</ipSecEnabled > 
</controllerNodeConfig>  
 
If ipSecEnabled is not true, this is a finding. 

<ipSecEna-
bled>true</ip-
SecEnabled > 

CCE-
8451
8-0 

NIST800
53-VI-
NET-
CFG-
00300 

Built-in NSX Thoroughly review the deployment.  
 
If the virtual network is not isolated, this is a finding. 

Procedural (Depend-
ent on Customer 
Configurations) 

CCE-
8451
9-8 

NIST800
53-VI-
NET-
CFG-
00301 

Built-in NSX Do a thorough check on the infrastructure design and deploy-
ment network diagram.  
 
If there are any non-hypervisors on the logical network data 
plane or if any untrusted hypervisors are used, this is a finding. 

Procedural (Depend-
ent on Customer 
Configurations) 

CCE-
8452
0-6 

NIST800
53-VI-
NET-
CFG-
00302 

Built-in NSX Use the vSphere Web Client to connect to the vCenter Server. As 
administrator, go to Home > Inventory > Networking. Select 
“DSwitch” for distributed portgroups. Select each dvPortgroup 
connected to active VMs requiring securing. Go to tab “Summary 
> Edit Settings > Policies > Security”.    

Reject 
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If Forged Transmits is not set to Reject, this is a finding. 

CCE-
8452
1-4 

NIST800
53-VI-
NET-
CFG-
00303 

Built-in NSX Use the vSphere Web Client to connect to the vCenter Server. As 
administrator, go to Home > Inventory > Networking. Select 
“DSwitch” for distributed portgroups. Select each dvPortgroup 
connected to active VMs requiring securing. Go to tab “Summary 
> Edit Settings > Policies > Security”.   
  
If Mac Address Changes is not set to Reject, this is a finding. 

Reject 

CCE-
8452
2-2 

NIST800
53-VI-
NET-
CFG-
00304 

Built-in NSX Use the vSphere Web Client to connect to the vCenter Server. As 
administrator, go to Home > Inventory > Networking. Select 
“DSwitch” for distributed portgroups. Select each dvPortgroup 
connected to active VMs requiring securing. Go to tab “Summary 
> Edit Settings > Policies > Security”. 
 
If Promiscuous Mode is not set to Reject, this is a finding. 

Reject 

CCE-
8452
3-0 

NIST800
53-VI-
NET-
CFG-
00306 

Built-in NSX Log in to VMware vSphere Web Client. Navigate to Networking 
and Security --> Installation and Upgrade. Go to the “Host Prepa-
ration” tab. Under the “VXLAN” column, select “View Configura-
tion”. 
 
If VMKNic Teaming Policy is not set to “Load Balance - SRCID”, 
this is a finding. 

Load Balance - 
SRCID 

CCE-
8452
4-8 

NIST800
53-VI-
NET-
CFG-
00308 

Built-in NSX Log into the vCenter web interface with credentials authorized 
for administration. Navigate to Networking and Security >> Fire-
wall. Expand “Default Section Layer 3” in Configuration. 
 
If the action for the Default Rule is “Allow”, this is a finding. 

Denied 

CCE-
8452
5-5 

NIST800
53-VI-
NET-

Built-in NSX Log on to vSphere Web Client with credentials authorized for ad-
ministration. Navigate and select Networking and Security >> Us-
ers and Domains. 

Procedural  
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CFG-
00311 

 
View each role and verify the users and/or groups assigned to it. 

CCE-
8452
6-3 

NIST800
53-VI-
NET-
CFG-
00312 

Built-in NSX From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Password Policy. View the 
values of the password format requirements.  
 
If Numeric Characters is not set to at least 1, this is a finding. 

1 

CCE-
8452
7-1 

NIST800
53-VI-
NET-
CFG-
00313 

Built-in NSX From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Password Policy. View the 
values of the password format requirements.  
 
If Special Characters is not set to at least 1, this is a finding. 

1 

CCE-
8452
8-9 

NIST800
53-VI-
NET-
CFG-
00316 

Built-in NSX Log on to vSphere Web Client with credentials authorized for ad-
ministration. Navigate and select Networking and Security >> Us-
ers and Domains. View each role and verify the users and/or 
groups assigned to it. 
 
If any user or service account has more privileges than required, 
this is a finding. 

Procedural  

CCE-
8452
9-7 

NIST800
53-VI-
NET-
CFG-
00317 

Built-in NSX Log into NSX Manager with built-in administrator account “ad-
min” and default manufacturer password “default”. 
 
If the NSX Manager accepts the default password, this is a find-
ing. 

Non-default pass-
word 

CCE-
8453
0-5 

NIST800
53-VI-
NET-
CFG-
00318 

Built-in NSX Log into vSphere Web Client with credentials authorized for ad-
ministration. Navigate to Networking and Security >> Firewall. 
Expand rule sections as necessary to view rules. 
 
If there are no rules configured to enforce authorizations, this is a 
finding. 

Procedural  
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CCE-
8453
1-3 

NIST800
53-VI-
NET-
CFG-
00321 

Built-in NSX From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Password Policy. View the 
values of the password format requirements.  
 
If Lower-Case Characters is not set to at least 1, this is a finding. 

1 

CCE-
8453
2-1 

NIST800
53-VI-
NET-
CFG-
00322 

Built-in NSX From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Password Policy.  
 
If Upper-Case Characters is not set to at least 1, this is a finding. 

1 

CCE-
8453
3-9 

NIST800
53-VI-
NET-
CFG-
00323 

En-
hanced 

NSX Log into vSphere Web Client with credentials authorized for ad-
ministration. Navigate and select Networking and Security >> 
Firewall tab to display a list of firewall rules deployed across the 
NSX environment. Click on the dropdown arrow to expand each 
firewall rule’s section. For each rule, select the pencil icon in the 
“Action” column. 
 
If the “Log” option has not been enabled for all rules, this is a 
finding. 

Log 

CCE-
8453
4-7 

NIST800
53-VI-
NET-
CFG-
00324 

En-
hanced 

NSX Log into vSphere Web Client with credentials authorized for ad-
ministration. Navigate and select Networking and Security >> 
SpoofGuard. Check the Default policy of each NSX Manager. 
 
If the mode is disabled, this is a finding. 

Enabled 

CCE-
8453
5-4 

NIST800
53-VI-
NET-
CFG-
00328 

Built-in NSX Log onto vSphere Web Client with credentials authorized for ad-
ministration. Navigate and select Networking and Security >> se-
lect the “NSX Edges” tab on the left-side menu. Double-click the 
Edge ID. 
 
Navigate to Manage >> Verify the configurations under “Settings, 
Firewall, Routing, Bridging, and DHCP Relay” are enabled only as 

Enabled 
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necessary to the deployment. 
 
If unnecessary services are enabled, this is a finding. 

CCE-
8453
6-2 

NIST800
53-VI-
NET-
CFG-
00329 

Built-in NSX If the built-in SSO administrator account is used for daily opera-
tions or there is no policy restricting its use, this is a finding. 

Procedural (Depend-
ent on Customer 
Configurations) 

CCE-
8453
7-0 

NIST800
53-VI-
NET-
CFG-
00330 

Built-in NSX From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Password Policy.  
 
If Restrict Reuse is not set to “5” or more, this is a finding. 

5 

CCE-
8453
8-8 

NIST800
53-VI-
NET-
CFG-
00340 

Built-in NSX Go to the vSphere Web Client URL https://client-host-
name/vsphere-client and verify the CA certificate is signed by an 
approved service provider. 
 
If a public key certificate from an appropriate certificate policy 
through an approved service provider is not used, this is a find-
ing. 

Procedural  

CCE-
8453
9-6 

NIST800
53-VI-
NET-
CFG-
00343 

Built-in NSX Log into vSphere Web Client with credentials authorized for ad-
ministration. Navigate and select Networking and Security >> 
Firewall. 
 
If there are services enabled that should not be, this is a finding. 

Procedural  

CCE-
8454
0-4 

NIST800
53-VI-
NET-
CFG-
00344 

Built-in NSX Log into vSphere Web Client with credentials authorized for ad-
ministration. Navigate and select Networking and Security >> 
Firewall. 
  
If ports, protocols, and/or services are not disabled or restricted 
as required by the PPSM, this is a finding. 

Procedural  
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CCE-
8454
1-2 

NIST800
53-VI-
NET-
CFG-
00360 

Built-in NSX Log onto vSphere Web Client with credentials authorized for ad-
ministration. Navigate and select Networking and Security >> 
“NSX Edges” tab on the left-side menu. Double-click the EdgeID. 
 
Click on the “Configure” tab on the top of the new screen, then 
Interfaces >> Check the “Connection Status” column for the asso-
ciated interface. 
 
If any inactive router interfaces are not disabled, this is a finding. 

Procedural 

CCE-
8454
2-0 

NIST800
53-VI-
NET-
CFG-
00372 

Built-in NSX Log on to NSX Manager with credentials authorized for admin-
istration. Navigate and select Backup and Restore >> Backup His-
tory. 
 
If backups are not being sent to a centralized location when 
changes occur or weekly, whichever is sooner, this is a finding. 

Procedural  

CCE-
8430
1-1 

NIST800
53-VI-
VC-CFG-
00060 

En-
hanced 

vCen
ter 

Ask the SA if hardened, patched templates are used for VM crea-
tion, properly configured OS deployments, including applications 
both dependent and non-dependent on VM-specific configura-
tions. 
 
If hardened, patched templates are not used for VM creation, 
this is a finding. The system must use templates to deploy VMs 
whenever possible. 

Hardened virtual 
machine templates 
to use for OS de-
ployments. 

CCE-
8430
2-9 

NIST800
53-VI-
ESXI-
CFG-
00061 

En-
hanced 

vCen
ter 

On the Home page of the vSphere Client, select Menu > Admin-
istration and click Roles. Select the VC from the Roles provider 
drop-down menu. Select the Virtual machine user (sample) role 
and click Privileges. 
 
If the Console Interaction privilege is assigned to the role, this is a 
finding. If SSH and/or terminal management services are exclu-
sively used to perform management tasks, this is not a finding. 

Disable Console in-
teraction privilege 



PRELIMINARY DRAFT 

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud IaaS Environments 86 

CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8430
3-7 

NIST800
53-VI-
ESXI-
CFG-
00065 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command:  
 
Get-VM | Where {$_.ExtensionData.Config.Hardware.Device.De-
viceInfo.Label -match ""parallel""}  
 
If a virtual machine has a parallel device present, this is a finding. 

Disconnect unau-
thorized parallel de-
vices 

CCE-
8430
4-5 

NIST800
53-VI-
ESXI-
CFG-
00066 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command:  
 
Get-VM | Where {$_.ExtensionData.Config.Hardware.Device.De-
viceInfo.Label -match ""serial""}  
 
If a virtual machine has a serial device present, this is a finding. 

Disconnect unau-
thorized serial de-
vices 

CCE-
8430
5-2 

NIST800
53-VI-
ESXI-
CFG-
00067 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command:  
 
Get-VM | Get-UsbDevice  
 
If a virtual machine has any USB devices or USB controllers pre-
sent, this is a finding. 

No USB device pre-
sent 

CCE-
8430
6-0 

NIST800
53-VI-
ESXI-
CFG-
00068 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
sched.mem.pshare.salt 
 
If sched.mem.pshare.salt exists, this is a finding. 

Remove the ad-
vanced setting 
sched.mem.pshare.s
alt 

CCE-
8430
7-8 

NIST800
53-VI-
ESXI-

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 

TRUE 
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ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CFG-
00070 

Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.copy.disable 
 
If isolation.tools.copy.disable does not exist or is not set to true, 
this is a finding. 

CCE-
8430
8-6 

NIST800
53-VI-
ESXI-
CFG-
00071 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.dnd.disable 
 
If isolation.tools.dnd.disable does not exist or is not set to true, 
this is a finding. 

TRUE 

CCE-
8430
9-4 

NIST800
53-VI-
ESXI-
CFG-
00072 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.setGUIOptions.enable 
 
If isolation.tools.setGUIOptions.enable does not exist or is not set 
to false, this is a finding. 

FALSE 

CCE-
8431
0-2 

NIST800
53-VI-
ESXI-
CFG-
00073 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.paste.disable 
 
If isolation.tools.paste.disable does not exist or is not set to true, 
this is a finding. 

TRUE 
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ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8431
1-0 

NIST800
53-VI-
ESXI-
CFG-
00074 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.diskShrink.disable 
 
If isolation.tools.diskShrink.disable does not exist or is not set to 
true, this is a finding. 

TRUE 

CCE-
8431
2-8 

NIST800
53-VI-
ESXI-
CFG-
00075 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.diskWiper.disable 
 
If isolation.tools.diskWiper.disable does not exist or is not set to 
true, this is a finding. 

TRUE 

CCE-
8431
3-6 

NIST800
53-VI-
ESXI-
CFG-
00076 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.hgfsServerSet.disable 
 
If isolation.tools.hgfsServerSet.disable does not exist or is not set 
to true, this is a finding. 

TRUE 

CCE-
8431
4-4 

NIST800
53-VI-
ESXI-
CFG-
00077 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.ghi.autologon.disable 
 

TRUE 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

If isolation.tools.ghi.autologon.disable does not exist or is not set 
to true, this is a finding. 

CCE-
8431
5-1 

NIST800
53-VI-
ESXI-
CFG-
00078 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.bios.bbs.disable 
 
If isolation.bios.bbs.disable does not exist or is not set to true, 
this is a finding. 

TRUE 

CCE-
8431
6-9 

NIST800
53-VI-
ESXI-
CFG-
00079 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.getCreds.disable 
 
If isolation.tools.getCreds.disable does not exist or is not set to 
true, this is a finding. 

TRUE 

CCE-
8431
7-7 

NIST800
53-VI-
ESXI-
CFG-
00080 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.ghi.launchmenu.change 
 
If isolation.tools.ghi.launchmenu.change does not exist or is not 
set to true, this is a finding. 

TRUE 

CCE-
8431
8-5 

NIST800
53-VI-
ESXI-
CFG-
00081 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.memSchedFakeSampleStats.disable 

TRUE 
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ID 
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tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

 
If isolation.tools.memSchedFakeSampleStats.disable does not 
exist or is not set to true, this is a finding. 

CCE-
8431
9-3 

NIST800
53-VI-
ESXI-
CFG-
00082 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.ghi.protocolhandler.info.disable 
 
If isolation.tools.ghi.protocolhandler.info.disable does not exist 
or is not set to true, this is a finding. 

TRUE 

CCE-
8432
0-1 

NIST800
53-VI-
ESXI-
CFG-
00083 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.ghi.host.shellAction.disable 
 
If isolation.ghi.host.shellAction.disable does not exist or is not set 
to true, this is a finding. 

TRUE 

CCE-
8432
1-9 

NIST800
53-VI-
ESXI-
CFG-
00084 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.dispTopoRequest.disable 
 
If isolation.tools.dispTopoRequest.disable does not exist or is not 
set to true, this is a finding. 

TRUE 

CCE-
8432
2-7 

NIST800
53-VI-
ESXI-

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 

TRUE 
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ID 
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ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CFG-
00085 

isolation.tools.trashFolderState.disable 
 
If isolation.tools.trashFolderState.disable does not exist or is not 
set to true, this is a finding. 

CCE-
8432
3-5 

NIST800
53-VI-
ESXI-
CFG-
00086 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.ghi.trayicon.disable 
 
If isolation.tools.ghi.trayicon.disable does not exist or is not set to 
true, this is a finding. 

TRUE 

CCE-
8432
4-3 

NIST800
53-VI-
ESXI-
CFG-
00087 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.unity.disable 
 
If isolation.tools.unity.disable does not exist or is not set to true, 
this is a finding. 

TRUE 

CCE-
8432
5-0 

NIST800
53-VI-
ESXI-
CFG-
00088 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.unityInterlockOperation.disable 
 
If isolation.tools.unityInterlockOperation.disable does not exist or 
is not set to true, this is a finding. 

TRUE 

CCE-
8432
6-8 

NIST800
53-VI-
ESXI-

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 

TRUE 
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In/En-
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Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CFG-
00089 

Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.unity.push.update.disable 
 
If isolation.tools.unity.push.update.disable does not exist or is 
not set to true, this is a finding. 

CCE-
8432
7-6 

NIST800
53-VI-
ESXI-
CFG-
00090 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.unity.taskbar.disable 
 
If isolation.tools.unity.taskbar.disable does not exist or is not set 
to true, this is a finding. 

TRUE 

CCE-
8432
8-4 

NIST800
53-VI-
ESXI-
CFG-
00091 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.unityActive.disable 
 
If isolation.tools.unityActive.disable does not exist or is not set to 
true, this is a finding. 

TRUE 

CCE-
8432
9-2 

NIST800
53-VI-
ESXI-
CFG-
00092 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.unity.windowContents.disable 
 
If isolation.tools.unity.windowContents.disable does not exist or 
is not set to true, this is a finding. 

TRUE 
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In/En-
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uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8433
0-0 

NIST800
53-VI-
ESXI-
CFG-
00093 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.vmxDnDVersionGet.disable 
 
If isolation.tools.vmxDnDVersionGet.disable does not exist or is 
not set to true, this is a finding. 

TRUE 

CCE-
8433
1-8 

NIST800
53-VI-
ESXI-
CFG-
00094 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.guestDnDVersionSet.disable 
 
If isolation.tools.guestDnDVersionSet.disable does not exist or is 
not set to true, this is a finding. 

TRUE 

CCE-
8433
2-6 

NIST800
53-VI-
ESXI-
CFG-
00095 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.vixMessage.disable 
 
If isolation.tools.vixMessage.disable does not exist or is not set to 
true, this is a finding. 

TRUE 

CCE-
8433
3-4 

NIST800
53-VI-
ESXI-
CFG-
00096 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
RemoteDisplay.maxConnections 
 

1 
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Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

If RemoteDisplay.maxConnections does not exist or is not set to 
1, this is a finding. 

CCE-
8433
4-2 

NIST800
53-VI-
ESXI-
CFG-
00097 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
RemoteDisplay.vnc.enabled 
 
If RemoteDisplay.vnc.enabled does not exist or is not set to false, 
this is a finding. 

FALSE 

CCE-
8433
5-9 

NIST800
53-VI-
ESXI-
CFG-
00098 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.tools.autoInstall.disable 
 
If isolation.tools.autoInstall.disable does not exist or is not set to 
true, this is a finding. 

TRUE 

CCE-
8433
6-7 

NIST800
53-VI-
ESXI-
CFG-
00099 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
tools.setinfo.sizeLimit 
 
If tools.setinfo.sizeLimit does not exist or is not set to 1048576, 
this is a finding. 

1048576 

CCE-
8433
7-5 

NIST800
53-VI-
ESXI-
CFG-
00100 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.device.edit.disable 

TRUE 
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If isolation.device.edit.disable does not exist or is not set to true, 
this is a finding. 

CCE-
8433
8-3 

NIST800
53-VI-
ESXI-
CFG-
00101 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
isolation.device.connectable.disable 
 
If isolation.device.connectable.disable does not exist or is not set 
to true, this is a finding. 

TRUE 

CCE-
8433
9-1 

NIST800
53-VI-
ESXI-
CFG-
00102 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
tools.guestlib.enableHostInfo 
 
If tools.guestlib.enableHostInfo does not exist or is not set to 
false, this is a finding. 

FALSE 

CCE-
8434
0-9 

NIST800
53-VI-
ESXI-
CFG-
00154 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-HardDisk | Select Parent, Name, 
Filename, DiskType, Persistence | FT -AutoSize 
 
If the virtual machine has attached disks that are in independent 
nonpersistent mode, this is a finding. 

Persistent 

CCE-
8434
1-7 

NIST800
53-VI-
ESXI-

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command:  
 

Disconnect unau-
thorized floppy de-
vices 
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CFG-
00155 

Get-VM | Get-FloppyDrive | Select Parent, Name, Connection-
State  
 
If a virtual machine has a floppy drive present, this is a finding. 

CCE-
8434
2-5 

NIST800
53-VI-
ESXI-
CFG-
00156 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command:  
 
Get-VM | Get-CDDrive | Where 
{$_.extensiondata.connectable.connected -eq $true} | Select 
Parent,Name  
 
If a virtual machine has a CD/DVD drive connected other than 
temporarily, this is a finding. 

Disconnect unau-
thorized CD/DVD 
drives 

CCE-
8434
3-3 

NIST800
53-VI-
ESXI-
CFG-
00185 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host run the following command:  
 
Get-VirtualPortGroup | Select Name, VLanID  
 
If any port group is configured with VLAN 4095 and is not docu-
mented as a needed exception, this is a finding. 

Not 4095 

CCE-
8434
4-1 

NIST800
53-VI-
NET-
CFG-
00341 

Built-in vCen
ter 

If the vCenter server is not joined to an Active Directory domain 
and not configured for Single Sign-On Identity Source of the Ac-
tive Directory domain, and Active Directory/CAC/PIV certificate-
based accounts are not used for daily operations of the vCenter 
server, this is a finding. 

Procedural (Depend-
ent on Customer 
Configurations) 

CCE-
8434
5-8 

NIST800
53-VI-
NET-
CFG-
00341 

Built-in vCen
ter 

If the vCenter server is not joined to an Active Directory domain 
and not configured for Single Sign-On Identity Source of the Ac-
tive Directory domain, and Active Directory/CAC/PIV certificate-
based accounts are not used for daily operations of the vCenter 
server, this is a finding. 

Procedural (Depend-
ent on Customer 
Configurations) 
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Prod-
uct 
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CCE-
8434
6-6 

NIST800
53-VI-
VC-CFG-
00401 

Built-in vCen
ter 

For applications sharing service accounts, create a new service 
account to assign to the application so that no application shares 
a service account with another. 
 
When standing up a new application that requires access to 
vCenter always create a new service account prior to installation 
and grant only the permissions needed for that application. 

Procedural (Depend-
ent on Customer 
Configurations) 

CCE-
8434
7-4 

NIST800
53-VI-
VC-CFG-
00402 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-VDPortgroup | select Name, VlanConfiguration 
 
If any port group is configured with VLAN 4095 and is not docu-
mented as a needed exception, this is a finding. 

Not 4095 

CCE-
8434
8-2 

NIST800
53-VI-
VC-CFG-
00403 

Built-in vCen
ter 

From the vSphere Web Client go to Administration >> Single Sign-
On >> Configuration >> Policies >> Password Policy.  
 
If Restrict Reuse is not set to 5 or more, this is a finding. 

5 

CCE-
8434
9-0 

NIST800
53-VI-
VC-CFG-
00404 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-AdvancedSetting -Entity <vcenter server name> -Name con-
fig.log.level  
 
If the level is not set to info, this is a finding. 

info 

CCE-
8435
0-8 

NIST800
53-VI-
VC-CFG-
00405 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the 
vCenter server run the following commands: 
 
Get-VDSwitch | Get-VDSecurityPolicy 
Get-VDPortgroup | Get-VDSecurityPolicy 

reject 
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uct 
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rameter Value 

 
If the Promiscuous Mode policy is set to accept, this is a finding. 

CCE-
8435
1-6 

NIST800
53-VI-
VC-CFG-
00406 

Built-in vCen
ter 

From the vSphere Web Client go to Administration >> Client Plug-
Ins. View the Installed/Available Plug-ins list and verify they are 
all identified as authorized VMware, 3rd party (Partner) and/or 
site-specific (locally developed and site) approved plug-ins. 
 
If any Installed/Available plug-ins in the viewable list cannot be 
verified as vSphere Client plug-ins and/or authorized extensions 
from trusted sources, this is a finding. 

N/A 

CCE-
8435
2-4 

NIST800
53-VI-
VC-CFG-
00407 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the 
vCenter server run the following commands: 
 
Get-VDSwitch | Get-VDSecurityPolicy 
Get-VDPortgroup | Get-VDSecurityPolicy 
 
If the MAC Address Changes policy is set to accept, this is a find-
ing. 

Authorized exten-
sions from Trusted 
Sources 

CCE-
8435
3-2 

NIST800
53-VI-
VC-CFG-
00408 

Built-in vCen
ter 

From the vSphere Web Client go to Administration >> Single Sign-
On >> Configuration >> Policies >> Password Policy.  
 
If Upper-Case Characters is not set to at least 1, this is a finding. 

1 

CCE-
8435
4-0 

NIST800
53-VI-
VC-CFG-
00409 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-VDSwitch | select Name,@{N="NIOC Enabled";E={$_.Exten-
sionData.config.NetworkResourceManagementEnabled}} 
 
If Network I/O Control is disabled, this is a finding. 

enabled 
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ID 
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tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8435
5-7 

NIST800
53-VI-
VC-CFG-
00410 

En-
hanced 

vCen
ter 

From the vSphere Web Client go to Administration >> Single Sign-
On >> Configuration >> Policies >> Password Policy.  
 
If the Minimum Length is not set to at least 15, this is a finding. 

15 

CCE-
8435
6-5 

NIST800
53-VI-
VC-CFG-
00411 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the 
vCenter server run the following commands: 
 
$vds = Get-VDSwitch 
$vds.ExtensionData.Config.HealthCheckConfig 
 
If the health check feature is enabled on distributed switches and 
is not on temporarily for troubleshooting purposes, this is a find-
ing. 

FALSE 

CCE-
8435
7-3 

NIST800
53-VI-
VC-CFG-
00412 

En-
hanced 

vCen
ter 

From the vSphere Client, select the vCenter server at the top of 
the hierarchy and go to Alarms >> Definitions. 
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-AlarmDefinition | Where {$_.ExtensionData.Info.Expres-
sion.Expression.EventTypeId -eq "vim.event.Permis-
sionUpdatedEvent"} | Select Name,Enabled,@{N="EventTyp-
eId";E={$_.ExtensionData.Info.Expression.Expression.EventTyp-
eId}} 
 
If there is not an alarm created to alert on permission update 
events, this is a finding. 

Procedural 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8435
8-1 

NIST800
53-VI-
VC-CFG-
00413 

Built-in vCen
ter 

From the vSphere Web Client go to Administration >> Single Sign-
On >> Configuration >> Policies >> Password Policy.   
 
If Lower-Case Characters is not set to at least 1, this is a finding. 

1 

CCE-
8435
9-9 

NIST800
53-VI-
VC-CFG-
00414 

En-
hanced 

vCen
ter 

From the vSphere Client, select the vCenter server at the top of 
the hierarchy and go to Alarms >> Definitions. 
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-AlarmDefinition | Where {$_.ExtensionData.Info.Expres-
sion.Expression.EventTypeId -eq "vim.event.Permis-
sionAddedEvent"} | Select Name,Enabled,@{N="EventTyp-
eId";E={$_.ExtensionData.Info.Expression.Expression.EventTyp-
eId}} 
 
If there is not an alarm created to alert on permission addition 
events, this is a finding. 

Procedural 

CCE-
8436
0-7 

NIST800
53-VI-
VC-CFG-
00415 

Built-in vCen
ter 

From the vSphere Web Client, go to Administration >> Access 
Control >> Roles. 
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-VIPermission | Sort Role | Select Role,Principal,Entity,Propa-
gate,IsGroup | FT -Auto 
 

Procedural (Depend-
ent on Customer 
Configurations) 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

Application service account and user required privileges should 
be documented. 
 
If any user or service account has more privileges than required, 
this is a finding. 

CCE-
8436
1-5 

NIST800
53-VI-
VC-CFG-
00416 

En-
hanced 

vCen
ter 

From the vSphere Client, select the vCenter server at the top of 
the hierarchy and go to Alarms >> Definitions. 
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-AlarmDefinition | Where {$_.ExtensionData.Info.Expres-
sion.Expression.EventTypeId -eq "vim.event.PermissionRe-
movedEvent"} | Select Name,Enabled,@{N="EventTyp-
eId";E={$_.ExtensionData.Info.Expression.Expression.EventTyp-
eId}} 
 
If there is not an alarm to alert on permission deletion events, 
this is a finding. 

Procedural 

CCE-
8436
2-3 

NIST800
53-VI-
VC-CFG-
00417 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-VDPortgroup | Select Name,VirtualSwitch,@{N="NetFlow-
Enabled";E={$_.Extensiondata.Config.defaultPortConfig.ipfixEna-
bled.Value}} 
 
If NetFlow is configured and the collector IP is not known and is 
not enabled temporarily for troubleshooting purposes, this is a 
finding. 

Known Ips 



PRELIMINARY DRAFT 

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud IaaS Environments 102 

CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8436
3-1 

NIST800
53-VI-
VC-CFG-
00418 

En-
hanced 

vCen
ter 

If no clusters are enabled for VSAN, this is not applicable. 
 
From the vSphere Web Client go to Host and Clusters >> Select a 
vCenter Server >> Configure >> vSAN >> Internet Connectivity >> 
Status. 
 
If a proxy is not configured, this is a finding. 

Procedural 

CCE-
8436
4-9 

NIST800
53-VI-
VC-CFG-
00419 

Built-in vCen
ter 

From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-VIPermission | Sort Role | Select Role,Principal,Entity,Propa-
gate,IsGroup | FT -Auto 
 
Application service account and user required privileges should 
be documented. 
 
If any user or service account has more privileges than required, 
this is a finding. 

Procedural (Depend-
ent on Customer 
Configurations) 

CCE-
8436
5-6 

NIST800
53-VI-
VC-CFG-
00420 

Built-in vCen
ter 

From the vSphere Web Client, go to Host and Clusters >> Select a 
Cluster >> Related Objects >> Datastores. Review the datastores. 
Identify any datastores with “vsan” as the datastore type. 
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
If($(Get-Cluster | where {$_.VsanEnabled} | Measure).Count -gt 
0){ 
Write-Host "VSAN Enabled Cluster found" 
Get-Cluster | where {$_.VsanEnabled} | Get-Datastore | where 

No name with 
“vsanDatastore” 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

{$_.type -match "vsan"} 
} 
else{ 
Write-Host "VSAN is not enabled, this finding is not applicable" 
} 
 
If VSAN is enabled and the datastore is named “vsanDatastore”, 
this is a finding. 

CCE-
8436
6-4 

NIST800
53-VI-
VC-CFG-
00421 

En-
hanced 

vCen
ter 

From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Password Policy.  
 
If Maximum Lifetime is not set to 60, this is a finding. 

60 

CCE-
8436
7-2 

NIST800
53-VI-
VC-CFG-
00422 

En-
hanced 

vCen
ter 

On the system where vCenter is installed, locate the webcli-
ent.properties file.  
 
/etc/vmware/vsphere-client/ and /etc/vmware/vsphere-ui/  
 
If session.timeout is not set to 10 (minutes), this is a finding. 

10 

CCE-
8436
8-0 

NIST800
53-VI-
VC-CFG-
00427 

En-
hanced 

vCen
ter 

Get-AdvancedSetting -Entity <vcenter server name> -Name con-
fig.vpxd.hostPasswordLength  

32 

CCE-
8436
9-8 

NIST800
53-VI-
VC-CFG-
00428 

Built-in vCen
ter 

From the vSphere Web Client, go to vCenter Inventory Lists >> 
vCenter Servers >> Select your vCenter Server >> Settings >> Ad-
vanced System Settings. 
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 

FALSE 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

Get-AdvancedSetting -Entity <vcenter server name> -Name Virtu-
alCenter.VimPasswordExpirationInDays 
 
If VirtualCenter.VimPasswordExpirationInDays is set to a value 
other than 30 or does not exist, this is a finding. 

CCE-
8437
0-6 

NIST800
53-VI-
VC-CFG-
00429 

Built-in vCen
ter 

Check the following conditions: 
1. The Update Manager must be configured to use the Update 
Manager Download Server.  
2. The use of physical media to transfer update files to the Up-
date Manager server (air-gap model example: separate Update 
Manager Download Server which may source vendor patches ex-
ternally via the Internet versus an internal source) must be en-
forced with site policies. 
 
To verify download settings, from the vSphere Client/vCenter 
Server system, click Update Manager. Select a Host and then click 
the Settings tab. In the Download Settings tab, find “Direct con-
nection to Internet”. 
 
If “Direct connection to Internet” is configured, this is a finding. 
If all of the above conditions are not met, this is a finding. 

Procedural 

CCE-
8437
1-4 

NIST800
53-VI-
VC-CFG-
00432 

Built-in vCen
ter 

From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Password Policy. 
 
If Special Characters is not set to at least 1, this is a finding. 

1 

CCE-
8437
2-2 

NIST800
53-VI-
VC-CFG-
00433 

Built-in vCen
ter 

From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Password Policy.  
 
If Numeric Characters is not set to at least 1, this is a finding. 

1 
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CCE 
ID 

Config-
ura-
tion(s) 

Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8437
3-0 

NIST800
53-VI-
VC-CFG-
00434 

En-
hanced 

vCen
ter 

From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Lockout Policy.  
 
If the Time interval between failures is not set to at least 900, this 
is a finding. 

900 

CCE-
8437
4-8 

NIST800
53-VI-
VC-CFG-
00435 

En-
hanced 

vCen
ter 

From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Lockout Policy.  
 
If the Unlock time is not set to 0, this is a finding. 

0 

CCE-
8437
5-5 

NIST800
53-VI-
VC-CFG-
00436 

En-
hanced 

vCen
ter 

From the vSphere Web Client, go to Administration >> Single 
Sign-On >> Configuration >> Policies >> Lockout Policy.  
 
If the Maximum number of failed login attempts is not set to 3, 
this is a finding. 

3 

CCE-
8437
6-3 

NIST800
53-VI-
VC-CFG-
00437 

En-
hanced 

vCen
ter 

From the vSphere Web Client go to vCenter Inventory Lists >> 
vCenter Servers >> Select your vCenter Server >> Settings >> 
Advanced Settings.  
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-AdvancedSetting -Entity <vcenter server name> -Name 
config.nfc.useSSL  
 
If config.nfc.useSSL is not set to true, this is a finding. 

TRUE 

CCE-
8437
7-1 

NIST800
53-VI-
VC-CFG-
00439 

Built-in vCen
ter 

If the built-in SSO administrator account is used for daily opera-
tions or there is no policy restricting its use, this is a finding. 

Procedural 
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ID 
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Built-
In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

CCE-
8437
8-9 

NIST800
53-VI-
VC-CFG-
00440 

En-
hanced 

vCen
ter 

From the vSphere Web Client, go to Networking >> Select a dis-
tributed port group >> Manage >> Settings >> Properties. View 
the Override port policies. 
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-VDPortgroup | Get-View | 
Select Name, 
@{N="VlanOverrideAllowed";E={$_.Config.Policy.VlanOverrideAl-
lowed}}, 
@{N="UplinkTeamingOverrideAllowed";E={$_.Config.Policy.Up-
linkTeamingOverrideAllowed}}, 
@{N="SecurityPolicyOverrideAllowed";E={$_.Config.Policy.Secu-
rityPolicyOverrideAllowed}}, 
@{N="IpfixOverrideAllowed";E={$_.Config.Policy.IpfixOverrideAl-
lowed}}, 
@{N="BlockOverrideAllowed";E={$_.Config.Policy.BlockOverride-
Allowed}}, 
@{N="ShapingOverrideAllowed";E={$_.Config.Policy.Shaping-
OverrideAllowed}}, 
@{N="VendorConfigOverrideAllowed";E={$_.Config.Policy.Ven-
dorConfigOverrideAllowed}}, 
@{N="TrafficFilterOverrideAllowed";E={$_.Config.Policy.Traf-
ficFilterOverrideAllowed}}, 
@{N="PortConfigResetAtDisconnect";E={$_.Config.Pol-
icy.PortConfigResetAtDisconnect}} | Sort Name 
 

disabled 



PRELIMINARY DRAFT 

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud IaaS Environments 107 

CCE 
ID 
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In/En-
hanced 

Prod-
uct 

Audit Procedure Recommended Pa-
rameter Value 

Note: This was broken up into multiple lines for readability. Ei-
ther paste as is into a PowerShell script or combine into one line 
and run. 
 
This does not apply to the reset port configuration on disconnect 
policy. 
 
If any port level overrides are enabled and not documented, this 
is a finding. 

CCE-
8437
9-7 

NIST800
53-VI-
VC-CFG-
00442 

En-
hanced 

vCen
ter 

From the vSphere Client, select the vCenter server at the top of 
the hierarchy and go to Alarms >> Definitions.  
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-AlarmDefinition | Where {$_.ExtensionData.Info.Expres-
sion.Expression.EventTypeId -eq "esx.problem.vmsyslogd.re-
mote.failure"} | Select Name,Enabled,@{N="EventTyp-
eId";E={$_.ExtensionData.Info.Expression.Expression.EventTyp-
eId}} 
 
If there is no alarm created to alert if an ESXi host can no longer 
reach its syslog server, this is a finding. 

Enabled 

CCE-
8438
0-5 

NIST800
53-VI-
VC-CFG-
00445 

Built-in vCen
ter 

If IP-based storage is not used, this is not applicable. 
 
IP-based storage (iSCSI, NFS, VSAN) VMkernel port groups must 
be in a dedicated VLAN that can be on a common standard or dis-
tributed virtual switch that is logically separated from other traf-
fic types. The check for this will be unique per environment.  

Unique IP Addresses  
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uct 

Audit Procedure Recommended Pa-
rameter Value 

 
From the vSphere Client, select Networks >> Distributed Port 
Groups and review the VLANs associated with any IP-based stor-
age VMkernels. 
 
If any IP-based storage networks are not isolated from other traf-
fic types, this is a finding. 

CCE-
8438
1-3 

NIST800
53-VI-
VC-CFG-
00447 

Built-in vCen
ter 

Log in to the vCenter server and view the local administrators 
group membership. 
 
If the local administrators group contains users and/or groups 
that are not vCenter Administrators such as “Domain Admins”, 
this is a finding. 

Only necessary users 
and groups 

CCE-
8438
2-1 

NIST800
53-VI-
VC-CFG-
00450 

Built-in vCen
ter 

From the vSphere Client, go to Home >> Networking. Select a dis-
tributed port group, click Edit, then go to Security. 
 
or 
 
From a PowerCLI command prompt, while connected to the 
vCenter server run the following commands: 
 
Get-VDSwitch | Get-VDSecurityPolicy 
Get-VDPortgroup | ?{$_.IsUplink -eq $false} | Get-VDSecurityPol-
icy 
 
If the Forged Transmits policy is set to accept for a non-uplink 
port, this is a finding. 

reject 

CCE-
8438
3-9 

NIST800
53-VI-
VC-CFG-
00455 

En-
hanced 

vCen
ter 

If the vSphere Storage API - Data Protection (VADP) solution is 
not configured for performing backup and restore of the man-
agement components, this is a finding. 

vSphere Storage API 
- Data Protection 
(VADP) 
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hanced 

Prod-
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CCE-
8438
4-7 

NIST800
53-VI-
VC-CFG-
00497 

Built-in vCen
ter 

On the Edit port group - VM Network window, check for input 
1611 for VLAN ID.  
 
If the vlan is 1611, this is a finding. 

Not 1611 

CCE-
8438
5-4 

NIST800
53-VI-
VC-CFG-
00555 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name svga.vgaonly 
 
If svga.vgaonly does not exist or is not set to false, this is a find-
ing. 

TRUE 

CCE-
8438
6-2 

NIST800
53-VI-
VC-CFG-
00561 

En-
hanced 

vCen
ter 

From a PowerCLI command prompt, while connected to the ESXi 
host or vCenter server run the following command: 
 
Get-VM "VM Name" | Get-AdvancedSetting -Name 
pciPassthru*.present 
 
If pciPassthru*.present does not exist or is not set to false, this is 
a finding. 

FALSE 

CCE-
8460
1-4 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00178 

En-
hanced 

vSAN From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-VIPermission | Where {$_.Role -eq "Admin"} | Select 
Role,Principal,Entity,Propagate,IsGroup | FT -Auto 
 
If there are any users other than Solution Users with the Adminis-
trator role that are not explicitly designated for cryptographic op-
erations, this is a finding. 

No Cryptography 
Administrator 

CCE-
8460
2-2 

NIST800
53-VI-

Built-in vSAN From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 

Correct date and 
timestamp  
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Stor-
age-
SDS-
CFG-
00180 

Get-VMHost | Get-VMHostNTPServer 
Get-VMHost | Get-VMHostService | Where {$_.Label -eq "NTP 
Daemon"} 
 
If the NTP service is not configured with authoritative DoD time 
sources and the service is not configured to start and stop with 
the host and is running, this is a finding. 

CCE-
8460
3-0 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00181 

Built-in vSAN Log in to the vRealize Log Insight user interface. Click the configu-
ration drop-down menu icon and select Content Packs. Under 
Content Pack Marketplace, select Marketplace. 
 
If the VMware - vSAN content pack does not appear in the In-
stalled Content Packs list, this is a finding. 

VMware - vSAN 

CCE-
8460
4-8 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00182 

Built-in vSAN From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name 
UserVars.HostClientSessionTimeout 
 
If UserVars.HostClientSessionTimeout is not set to 900, this is a 
finding. 

900 

CCE-
8460
5-5 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00183 

En-
hanced 

vSAN From the vSphere client, select the cluster. Click the Configure 
tab and under vSAN, click Services. 
 
If Encryption is not enabled or the KMS cluster is not configured, 
this is a finding. 

Enabled 
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CCE-
8460
6-3 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00184 

Built-in vSAN Perform a compliance check on the inventory objects to make 
sure that you have all the latest security patches and updates ap-
plied. Use the vSphere Client to log in to a vCenter Server Appli-
ance, or to a vCenter Server system with which Update Manager 
is registered. 
 
If all the latest security patches and updates are not applied, this 
is a finding. 

Up-to-Date Patches 
and Upgrades 

CCE-
8460
7-1 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00185 

Built-in vSAN From a PowerCLI command prompt, while connected to the ESXi 
host run the following command: 
 
Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost 
 
If Syslog.global.logHost is not set to a site-specific syslog server, 
this is a finding. 

udp://sfo01vrli01.sf
o01.rainpole.lo-
cal:514 

CCE-
8460
8-9 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00204 

En-
hanced 

vSAN From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
Get-VIPermission | Where {$_.Role -eq "Admin"} | Select 
Role,Principal,Entity,Propagate,IsGroup | FT -Auto 
 
If there are any users other than Solution Users with the Adminis-
trator role that are not explicitly designated for cryptographic op-
erations, this is a finding. 

No Cryptography 
Administrator 

CCE-
8460
9-7 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00207 

En-
hanced 

vSAN If VSAN Health Check is installed: 
From the vSphere Client, go to Host and Clusters. Select a VC and 
go to Configure > vSAN > Internet Connectivity > Status. 
 
If “Enable Internet access for this cluster” is enabled and a proxy 
is not configured, this is a finding. 

Proxy should be con-
figured 
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CCE-
8461
0-5 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00208 

Built-in vSAN From a PowerCLI command prompt, while connected to the 
vCenter server run the following command: 
 
If($(Get-Cluster | where {$_.VsanEnabled} | Measure).Count -gt 
0){ 
Write-Host "VSAN Enabled Cluster found" 
Get-Cluster | where {$_.VsanEnabled} | Get-Datastore | where 
{$_.type -match "vsan"} 
} 
else{ 
Write-Host "VSAN is not enabled, this finding is not applicable" 
} 
 
If VSAN is enabled and the datastore is named “vsanDatastore”, 
this is a finding. 

Datastore name is 
unique 

CCE-
8461
1-3 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00179  

En-
hanced 

vSAN  From a PowerCLI command prompt, while connected to the ESXi 
host run the following commands: 
 
$esxcli = Get-EsxCli 
$esxcli.system.coredump.network.get() 
 
If there is no active core dump partition or the network core 
dump collector is not configured and enabled, this is a finding. 

TRUE 

CCE-
8461
2-1 

NIST800
53-VI-
Stor-
age-
SDS-
CFG-
00186 

En-
hanced 

vSAN  Make sure you have sufficient capacity in the management vSAN 
cluster for the management virtual machines. 
 
If you do not have sufficient capacity, this is a finding. 

Procedural  

932 
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Appendix B List of Acronyms 933 

API Application Programming Interface 

BOM Bill of Materials 

CCE Common Configuration Enumeration 

DISA Defense Information Systems Agency 
HSM Hardware Security Module 

IaaS Infrastructure as a Service 
IT Information Technology 

KMS Key Management System 
NCCoE National Cybersecurity Center of Excellence 

NIST National Institute of Standards and Technology 

NISTIR National Institute of Standards and Technology Interagency Report 

NSX-V NSX for vSphere 

OS Operating System 

PSC Platform Services Controller 
SDDC Software Defined Data Center 

SLES SUSE Linux Enterprise Server 

SMTP Simple Mail Transfer Protocol 

SP Special Publication 

STIG Security Technical Implementation Guide 

UI User Interface 
UMDS Update Manager Download Service 

VADP vSphere Storage APIs for Data Protection 

vCS vSphere vCenter Server 

VM Virtual Machine 

vR vSphere Replication 

vRA vRealize Automation 
vRLI vRealize Log Insight 

vROPS vRealize Operations Manager 

VVD VMware Validated Design 
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Appendix C Glossary 934 

All significant technical terms used within this document are defined in other key documents, 935 
particularly National Institute of Standards and Technology Interagency Report (NISTIR) 7904, Trusted 936 
Geolocation in the Cloud: Proof of Concept Implementation. As a convenience to the reader, terms 937 
critical to understanding this volume are provided in this glossary. 938 

Cloud workload A logical bundle of software and data that is present in, and processed by, a 
cloud computing technology. 

Geolocation Determining the approximate physical location of an object, such as a cloud 
computing server. 

Hardware root of 
trust 

An inherently trusted combination of hardware and firmware that maintains 
the integrity of information. 

Trusted compute 
pool 

A physical or logical grouping of computing hardware in a data center that is 
tagged with specific and varying security policies. Within a trusted compute 
pool, the access and execution of applications and workloads are monitored, 
controlled, audited, etc. Also known as a trusted pool. 
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